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What is Windows Write?
Microsoft Write is a word-processing application. You can use Write to create and print documents such 
as reports and letters.
When you first start Write, a blank untitled Write window opens. You type, edit, and format your text in 
the workspace in this window.

When you create a document, you generally follow these steps:
Type the contents.
Edit the text.
Format the document.
Save your work.
Print the document.
Related Concepts



Concepts
How Text Editing Works
How Text Entry Works
How Text Formatting Works
How Write Prints Documents
How Write Saves and Opens Files



insertion point
The place where text will be inserted when you type.The insertion point appears as a flashing vertical 
bar.
When you start Write, the insertion point appears in the upper left corner. You cannot move the insertion 
point past the end mark, which indicates the end of your document. The mouse pointer indicates where 
the insertion point appears if you click the mouse button over a body of text.



document end marker
Marks the end of the document.



page status
Indicates the current page of your document. "Page 1" appears in the page status area until you break 
the document into pages.



How Text Entry Works
When you are ready, just start typing. Your text starts filling the Write Window at the insertion point. 
When you reach the end of the line, Write automatically moves the insertion point to the beginning of the
next line. 
When you want to start a new paragraph, press ENTER. If you want to indent the first line of the 
paragraph, press the TAB key. If you want to leave a blank line between paragraphs, press ENTER twice.   



hint
You can erase typing mistakes as you go by pressing the BACKSPACE key. With BACKSPACE, the insertion 
point erases the character to its left. Then you can type the correct letter.



How Text Editing Works
Write provides all the basic Windows editing features and several special ones. For example, you can 
cut and paste your text.
Within the Write window you can:

Move the insertion point.
Select text.
Find and change text.
Break your document into pages.
Add a picture to your text.
Insert optional hyphens.

See Windows Basics for a discussion of text editing basics.
Related Concepts



Concepts
Optional Hyphens
Page Breaks
Pictures and Charts
Text Selection
The Insertion Point
The Search and Replace Feature



The Insertion Point
The Write window often shows only part of your document. You can use the scroll bars or the PAGE UP 
and PAGE DOWN keys to view different parts of your text.
You move the insertion point by clicking your mouse, or by pressing the arrow keys. Write also provides 
several keys for moving the insertion point. For example, you can move to the next sentence, the next 
page, or the end of the document.

Related Topics



Keys
Movement Keys

Procedure
Moving the Insertion Point



Text Selection
In Write, many of the commands require that you select text before you choose the command. For 
example, to format a word with bold, you select the word, then choose Bold from the Format menu.
Selected text is highlighted. The easiest way to select text is to move the mouse pointer to the beginning
of the text and drag it to the end of the text you want to select.

Write also provides a selection area for using with your mouse. The selection area is at the far left edge 
of the Write window and makes selecting one or more lines easy with a mouse.

Related Procedures



mouse pointer
In Windows, the shape of the pointer indicates its function.

For selecting Windows items, scrolling, resizing windows, 
and moving windows and dialog boxes with your mouse. 
This is the pointer you will see most often.

For selecting text with your mouse.

For changing the size of a window with your mouse.

For changing the location or size of a window with your 
keyboard.

For indicating the application is processing your request.

selected text
Text marked by highlighting it with key combinations or with a mouse. Selecting text does not initiate an 
action. After selecting text, you choose the action that affects or involves the text. For example, you can 
select text and then choose the Copy command to copy the text onto the Clipboard.



selection area
An invisible area that extends vertically along the left margin of the Write window. The pointer slants to 
the right when it is in the selection area. Following are a few examples of how you can select text in the 
selection area:

To select Do this
A single line Point to a line with the pointer in the selection area and click the mouse button.
Several lines Point to a line, hold down the mouse button, and drag the pointer up or down within the

selection area.
A paragraph Point to a paragraph with the pointer in the selection area and double-click the mouse 

button.



Procedures
Selecting Text
Selecting Text Using the Selection Area



The Search and Replace Feature
Sometimes you'll want to find and replace a specific word in your document. (Click        for an 
example.) You can find any character, word, or group of characters or words. Write first searches from 
the insertion point to the end of your document. Then, it searches from the beginning of the document to 
the insertion point. It stops when it finds a match.
You can replace text in two ways. Write can:

Stop at each occurrence of the text you specify and wait for you to indicate whether to make the 
change or not.

Replace automatically all occurrences of the character, word, or words that you specify with your 
new entry.

If you make a selection before choosing Change, you can limit your changes to the selected text.
Related Procedure



example
Suppose you need to change a date throughout a lengthy document. You could search for occurrences 
of July 11 and change them to August 17.



Optional Hyphens
Occasionally you might find a large gap at the end of a line where a long word has wrapped to the next 
line. You can eliminate these gaps by inserting optional hyphens in long words. Write then uses these 
hyphens to break the words only when they appear at the end of a line. Optional hyphens are invisible 
unless the words appear at the end of a line. A regular hyphen is always visible.

Related Procedure



Page Breaks
When you print a document, Write breaks it into pages automatically. You can control the placement of 
the breaks by adding them manually and repaginating the entire document.
NOTE: Write prevents a single line in a paragraph from printing by itself at the top or bottom of the page.

Related Procedure



Pictures and Charts
You can paste a picture or chart into your Write document. For example, you can create a logo in 
Paintbrush, then paste it into your letter in Write.
Write places the picture at the left margin. You can move the picture horizontally or resize it. You can 
also cut, copy, and paste the picture just as you would text.

Related Procedures



Procedures
Changing the Size of a Picture
Moving Pictures
Pasting, Copying, and Cutting Pictures



How Text Formatting Works

When you format a document, you determine the way text appears on a page. You can determine:
Character formats, such as bold.
Paragraph formats, such as line spacing.
Document formats, such as margins.

Most of the formats you choose look the same on your screen as in the printed document.
Related Concepts



Concepts
Character Formats
Document Formats
Paragraph Formats



Character Formats

You can change the look of your document by using one or more of the character formats from the 
Character menu.    
You can choose a format for text before or after you type it. If you choose a format first, whatever you 
type next will have that format until you cancel it by choosing the format again. If you select the text 
before you apply a format, only your selection is formatted. 
Write will display and print the formats supported by your default printer. To use other formats, you must 
change the default printer.

Related Procedures



bold
Describes a character style in which the text is darkened. Other styles include italic, underline, 
superscript, and subscript.



Courier
A type of font. Examples of other font types are AvantGarde and Modern.
In Write, you can also change the size of a font.



superscript
Describes a character style in which the text appears slightly above other text. Other styles include italic,
underline, bold, and subscript.



Procedures
Changing Character Styles
Changing Fonts and Font Sizes
Changing Printers and Printer Options
Creating Subscript and Superscript Text



example
You can change font size. Font styles include bold, underline, and italic.



Paragraph Formats

You can change the look of your document by using one or more of the paragraph formats Write 
provides. For example, you can center the title of your report or indent a quotation.
Each paragraph ends with an invisible paragraph mark. This mark stores the formats that determine how
the paragragraph looks. The next paragraph automatically has the same formats as the previous one.   

Related Procedures



centered paragraph
Paragraph centered between the margins. In Write, you can align paragraphs in the following ways:

At the left margin.
At the right margin.
Justified between both paragraphs.

You can use either the ruler or the Paragraph menu commands to format your paragraphs.



double spaced paragraph
Paragraph with double-spaced line spacing. In Write, paragraphs can also be single spaced and 1 1/2 
spaced.
You can use either the ruler or the Paragraph menu commands to format your paragraphs.



indented paragraph
Paragraph indented from the left margin. In Write, you can also create hanging indents.
You can use either the ruler or the Paragraph menu commands to format your paragraphs.



Procedures
Changing Paragraph Alignment
Changing Paragraph Indents
Changing Paragraph Line Spacing
Creating Hanging Indents
Formatting Paragraphs with the Ruler



example
If you type a paragraph that is double-spaced and press ENTER to start a new paragraph, the text you 
type in the new paragraph will be double-spaced also.



Document Formats

You can change the look of your document by using one or more of the formats that affect the entire 
document. For example, you can change the margins and add page numbers to the bottom of each 
page.
When you start a new document, Write automatically sets the following:

Top and bottom margins of 1 inch.
Left and right margins of 1.25 inches.
Tabs at every 1/2 inch.
Headers and footers you specify at 0.75 inches from the edge of the page.

You can change the settings for margins and tabs.
Related Procedures



margins
The boundries of the text on the page.



tabs
Includes both left-aligned and decimal tabs.



footer
Text that appears at the bottom of every page. Typically, a footer contains page numbers.
In Write, you can also create headers. Typically, a header contains a title or page numbers.



Procedures
Adding Headers, Footers, and Page Numbers
Changing Page Layout
Changing Tabs with the Ruler
Changing Tabs with the Tabs Command



How Write Saves and Opens Files
When you create a new document, it does not have a filename. The title bar says "Write--(Untitled)." To 
give a document a filename and store it on your disk, you must save it. Write automatically adds the 
extension .WRI to the name you give it. However, you can save a document with another extension and 
in another format. Write can save documents as Write files, text files, and Word for MS-DOS files.    
You can open files in Write that were not created with Write, such as text files and Word for MS-DOS 
files. The size of your Write files is limited by the amount of memory in your computer. However, very 
large files can slow down Write's processing speed.

Related Procedures



Procedures
Creating New Documents
Making Backup Copies
Opening Existing Documents
Saving Documents



example
You can save your file as LETTER.DOC in Word for MS-DOS format. Then you can open it later in Word
and work on it.



text file
A file containing only plain text, numbers or symbols. The text in a text file is uniform and does not 
contain any formatting, such as bold, underline, or different fonts and font sizes. A text file usually 
consists of characters coded from the ASCII character set. 
The advantage of a text file is that it can be transferred to almost any text editor or word processor. Also,
MS-DOS and Windows use certain kinds of text files, such as AUTOEXEC.BAT, CONFIG.SYS, and 
WIN.INI.



How Write Prints Documents
You can print your document after you install a printer. Write uses the default printer, and matches the 
character formats you choose to the formats your printer can print. For example, your printer must 
support italic to print your text in italic format.
If you want to use a different intalled printer, you can change printers from within Write. If you want to 
use an inactive printer, however, you must first make it active using Control Panel.

Related Procedures



Procedures
Changing Printers and Printer Options
Choosing the Active Printer for a Port
Printing Documents













Character menu commands affect both selected text and the text you type.



To change the formatting for a single paragraph, place the insertion point anywhere in the 
paragraph. To change more than one paragraph, select text in those paragraphs.





New Command

Creates a new document.
When you choose this command, Write lets you save changes to the current document before opening 
the new document.

Related Procedure



Open Command

Opens an existing document.
When you choose this command, Write lets you save changes to the current document before opening 
the new document.
Write can open:

Write documents.
Windows application documents saved as text files.

Choose No Conversion when prompted.
Microsoft Word for MS-DOS documents.

Choose Convert when prompted.
Non-Windows application documents saved as text files.

Choose Convert when prompted.
CAUTION: Be sure you back up a file before you convert it to the Write format. Also, do not convert any 
files that are not purely text files. In binary files, ASCII characters above 127 might be related to the 
program that created the file and, therefore, cannot be converted. Other files might contain control 
characters that should not be converted.

Related Procedure



Save Command

Saves changes to the current document.
When you choose this command, the document remains open so you can continue working on it.

Related Procedure



Save As Command

Saves a new document or an existing document under another name.
You can save:

A new document in Write format.
A document as text only.
A document in Microsoft Word for MS-DOS format.
An existing document under another name.

You might want to rename a document so that you can change it without modifying the original.
A backup copy.
Related Procedures



Procedures
Making Backup Copies
Saving Documents



Print Command

Prints the current document.
If you have connected and installed a printer, you can print the document. Write automatically prints to 
the default printer.
In the dialog box, you can specify the following options:

This option Does this
Copies Indicates the number of copies to be printed.
Pages: All Prints all the pages in the document.
Pages: From/To Prints a range of pages. After you select this option, type page numbers in the From 

and To boxes.
Draft Quality Prints quickly an unformatted copy of the document text. (Pictures print as empty 

boxes.) If Draft Quality is dimmed, this option is not available for the selected printer.
When printing, Write uses the margin settings in the Page Layout dialog box.

Related Procedures



Procedures
Changing Page Layout
Installing New Printers
Printing Documents



Printer Setup Command

Sets printer options for Write before printing.
You can:

Select a default printer for Write.
Choose Setup and change options for the printer.

The available options depend on the type of printer selected.
Related Procedure



Repaginate Command

Repaginates a document and shows page breaks on the screen.
Write automatically paginates a document when you print. However, with this command, you can 
approve or move the automatic page breaks. You can also approve or move manual page breaks.
Select the Confirm Page Breaks box if you want to approve each page break or move any page breaks.

Related Procedure



Exit Command

Exits Write and closes the Write window.
If the document is unsaved, Write lets you save it before exiting.



Undo Command

Undoes your last typing, editing, or formatting action.
The name of the Undo command often reflects your last action. For example, if your last action was an 
editing change, the Edit menu will show Undo Editing.

Related Procedure



Cut Command

Cuts text or graphics from a document and places it on the Clipboard, erasing the previous Clipboard 
contents.
You can then use Paste to place the cut text or graphics in the same document, another document, or 
another application.

Related Procedures



Procedures
Copying and Cutting Pictures
Copying and Moving Text



Copy Command

Copies text or graphics from your document and places it on the Clipboard, leaving the original intact 
and erasing the previous Clipboard contents.
You can then use Paste to place the copied text or graphics in the same document, another document, 
or another application.

Related Procedures



Paste Command

Pastes a copy of the Clipboard contents at the insertion point or replaces selected text or graphics with 
the Clipboard contents.
The Clipboard contents can be either text or graphics. You can choose this command repeatedly to 
paste the Clipboard contents in more than one location.

Related Procedures



Procedures
Copying and Moving Text
Pasting Pictures



Move Picture Command

Moves a picture horizontally.
When you choose Move Picture, the pointer changes shape. Use the arrow keys or mouse to move the 
picture frame where you want the picture to appear.

Related Procedure



Size Picture Command

Changes the size of a picture.
When you choose Size Picture, the pointer changes shape. Use the arrow keys or mouse to change the 
size of the frame for the picture.

Related Procedure



Find Command

Finds text in a Write document.
You can start searching for text at any point in your document. You can specify whether Write should 
match uppercase and lowercase characters of the text and should find only whole words.
Write can also find tabs, paragraph marks, page breaks, wildcard characters, or spaces.
Write starts a search at the insertion point or at the end of selected text. It stops at the first match. To 
search for the next occurrence of the text, choose the Repeat Last Find command.
When it reaches the end of the document, Write automatically continues searching from the beginning of
the document to the starting point of the search. If you want to edit found text, click the mouse button or 
press ALT+F6 to switch from the Find dialog box to the document.

Related Procedure



Repeat Last Find Command

Repeats the last search without opening the Find dialog box.
Use this command when you don't want to display the Find dialog box but want to search immediately 
for the specified text.

Related Procedure



Change Command

Searches for and changes text.
With one exception, this command searches for text just as the Find command does. The exception is 
that if you select text before choosing this command, the search is limited to the selected text.
You can use the following buttons when changing text:

This button Does this
Find Next Finds the next occurrence of the search text. To switch back to the document, 

click the text or press ALT+F6.
Change, then Find Changes the currently selected search text, and then finds the next occurrence. 

If no text is selected, choosing this option finds the first occurrence of the 
search text.

Change Changes the currently selected search text.
Change All Changes all occurrences of the search text in the document.
Change Selection Changes all occurrences of the search text in the selected section of the 

document. The Change All button is replaced by a Change Selection button if 
you select text in your document.

Related Procedure



Go To Page Command

Goes to a specific page in the document.
To use the Go To Page command, you must first create page breaks by printing or repaginating the 
document.

Related Procedures



Procedures
Going to Specific Pages
Printing Documents
Repaginating Documents



Normal Command

Changes the character style to plain text.
Related Procedure



Bold Command

Changes the character style to bold.
Related Procedure



Italic Command

Changes the character style to italic.
Related Procedure



Underline Command

Underlines text.
Related Procedure



Superscript Command

Positions text above other text.
Superscript text is also scaled to a smaller size.

Related Procedure



Subscript Command

Positions text below other text.
Subscript text is also scaled to a smaller size.

Related Procedure



Font Names

Changes the character format to a different font.
The Character menu lists up to three font names, such as Courier, Modern, or AvantGarde. The font 
names that appear are the fonts you use most often.
If possible, Write uses the same fonts and sizes on your screen that you will see when you print your 
document. If Write cannot exactly match the selected fonts, it substitutes a font that resembles the 
selected font as closely as possible.

Related Procedure



Reduce Font Command

Reduces the font size to the next available size.
If you choose this command and the default printer does not support the next smaller or larger size, the 
text you type or selected does not change size on the screen.

Related Procedure



Enlarge Font Command

Increases the font size to the next available size.
If you choose this command and the default printer does not support the next smaller or larger size, the 
text you type or selected does not change size on the screen.

Related Procedure



Fonts Command

Changes the font and/or font size to a font not listed on the Character menu.
When you choose Fonts, a dialog box appears that lets you select from all available fonts and font sizes.
You can also enter the name of a font that is not currently installed on your computer. You might enter 
the name of a font if later you plan to install the font on your computer or open the document on a 
computer that has the font.
The default printer determines the fonts that are available. If you plan to print the document on a printer 
other than the default printer, you must set up the other printer using Control Panel and make it the 
default printer with Write's Printer Setup command. Then its fonts will be available for text in your 
document.

Related Procedures



Procedures
Changing Fonts and Font Sizes with the Fonts Command
Changing Printers and Printer Options
Installing New Printers



Normal Command

Changes the formatting to a single-spaced paragraph aligned with the left margin.
Pictures are also aligned at the left margin, with a single space between the picture and any text above 
or below the picture.

Related Procedures



Procedures
Changing Paragraph Alignment
Changing Paragraph Line Spacing



Left Command

Aligns paragraphs or pictures with the left margin.
You can also align paragraphs and pictures with the left margin by clicking an icon on the ruler.

Related Procedures



Procedures
Changing Paragraph Alignment
Formatting Paragraphs with the Ruler



Centered Command

Centers paragraphs or pictures between the left and right margins.
You can also center paragraphs and pictures by clicking an icon on the ruler.

Related Procedures



Right Command

Aligns paragraphs or pictures with the right margin.
You can also align paragraphs and pictures with the right margin by clicking an icon on the ruler.

Related Procedures



Justified Command

Aligns paragraphs with both the left and right margins.
You can also align paragraphs and pictures with the left and right margins by clicking an icon on the 
ruler.

Related Procedures



Single Space Command

Changes line spacing to single-spaced.
You can also change line spacing to single-spaced by clicking an icon on the ruler.

Related Procedures



Procedures
Changing Paragraph Line Spacing
Formatting Paragraphs with the Ruler



1 1/2 Space Command

Changes line spacing to 1 1/2 lines.
You can also change line spacing to 1 1/2 lines by clicking an icon on the ruler.

Related Procedures



Double Space Command

Changes line spacing to double-spaced.
You can also change line spacing to double-spaced by clicking an icon on the ruler.

Related Procedures



Indents Command

Sets left, right, and first-line indents for an entire paragraph.
The values in the Left Indent and Right Indent boxes specify how much to indent a paragraph from the 
left and right margins. The value in the First Line box indicates how much to indent the first line of the 
paragraph from the rest of the paragraph.
Indenting the lines of a paragraph differs from changing the left or right margins for a paragraph. Write 
indents paragraph lines from the current margin setting.
You can create a hanging indent by typing a positive number in the Left Indent box and a negative 
number in the First Line box. (In a paragraph with a hanging indent, the first line extends farther to the 
left than the rest of the paragraph as would happen in a numbered or bulleted list.)

Related Procedures



Procedures
Changing Paragraph Indents
Creating Hanging Indents



Header Command

Creates a header for the printed document.
In the Page Header dialog box, you can:

Specify the header's distance from the top of the page.
Set the header to appear on the first printed page.

Otherwise, the header first appears on the second page.
Insert page numbers as headers.
Clear all headers from the document.
Return to the document.

In the header window, you can type text you want to appear in the printed document. You can format the
text as you would any other text in the document.

Related Procedure



Footer Command

Creates a footer for the printed document.
In the Page Footer dialog box you can:

Specify the footer's distance from the bottom of the page.
Set the footer to appear on the first printed page.

Otherwise, the footer first appears on the second page.
Insert page numbers as footers.
Clear all footers from the document.
Return to the document.

In the footer window, you can type text you want to appear in the printed document. You can format the 
text as you would any other text in the document.

Related Procedure



Ruler On Command

Displays the Ruler at the top of the window.
Once you've turned on the Ruler, you can change line spacing and paragraph alignment by clicking the 
icons with your mouse. You can also add tabs by clicking the Ruler and remove tabs by dragging the 
tabs from the Ruler.

Related Procedures



Procedures
Changing Tabs with the Ruler
Formatting Paragraphs with the Ruler



Tabs Command

Sets left-aligned and decimal tabs.
Write has tabs preset at every half inch. Tabs that you set override the preset tabs. You can set up to 12 
tabs--left-aligned tabs and decimal tabs. Decimal tabs let you create a column of numbers that line up 
on their decimal points.
Tabs are measured from the left margin.

Related Procedure



Page Layout Command

Sets page layout options.
You can specify:

The starting page number for your document.
This number appears in your document if you included a page number in your header or footer. If you 
specify a starting page number, Write adjusts the page numbers displayed in the lower-left corner of 
the window. Write also uses the adjusted page numbers for the Go to Page command.

The margins for the printed page.
The system of measurement (English or metric) used in Write.

The system of measurement you choose is also used for such items as headers, footers, and indents.
Related Procedures



Procedures
Adding Headers, Footers, and Page Numbers
Changing Page Layout
Going to Specific Pages
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Moving the Insertion Point
To move the insertion point:

Move the pointer where you want the insertion point to appear and click the left mouse button 
once.

Keyboard Procedure



Selecting Text
To select text:
1 Point to the first character you want to select.
2 Drag the pointer to the last character you want to select.
3 Release the mouse button.

To select a single word:
Double-click the word.

To cancel a selection:
Click anywhere in the document to cancel the selection.
Keyboard Procedure



Selecting Text Using the Selection Area
The selection area is an invisible area that extends vertically along the left margin of the Write window. 
The pointer slants to the right when it is in the selection area.

To select Do this
A single line Point to a line with the pointer in the selection area and click the mouse button.
Several lines Point to a line, hold down the mouse button, and drag the pointer up or down 

within the selection area.
A paragraph Point to a paragraph with the pointer in the selection area and double-click the 

mouse button.
Several paragraphs Point to a paragraph with the pointer in the selection area, double-click, and hold

the mouse button down. Drag the pointer up or down within the selection area.
A range of text Select the starting line or paragraph. Hold down the SHIFT key while pointing to 

the ending line or paragraph with the pointer in the selection area. Then click the 
mouse button. Write selects everything between the two points.

The entire document Move the pointer to the selection area. Hold down the CTRL key and click the 
mouse button.



Copying and Moving Text
To copy or move text:
1 Select the text you want to copy or move.
2 Move the pointer where you want to insert the text.
3 Hold down ALT and click the mouse button to copy the selected text.

Or hold down SHIFT+ALT and click the mouse button to move the selected text.
Keyboard Procedure



Finding Text
Write starts searching at the insertion point or at the end of selected text. When it reaches the end of the
document, Write automatically continues searching from the beginning of the document to the starting 
point of the search.

To find text:
1 Move the insertion point where you want the search to begin.
2 Choose Find from the Search menu.
3 Type the search text in the Find What box.

To search for text that includes tabs, paragraph marks, page breaks, wildcard characters, or spaces, 
use the following characters (where ^ means the caret symbol) in the Find What box:

Type To search for
^d A manual page break.
^p A paragraph mark.
^t A tab character.
^w A space character.
? Any character. For example, if you type hea? in the Find What box, Write finds every 

word with hea, such as headstrong, figurehead, heal, heap, or heat.
4 Select the Whole Word check box to find occurrences of the search text that are entire words only.

Otherwise, Write finds, for example, main in remainder.
5 Select the Match Upper/Lowercase check box to match capitalization exactly.

Otherwise, Write finds, for example, both Main and main.
6 Choose Find Next to start the search.

Write searches for the text and selects the first occurrence. If you want to edit the text, click the 
mouse button or press ALT+F6 to switch from the Find dialog box to the document.

7 Choose Find Next again to find the next occurrence of the search text.

To search without the Find dialog box:
1 Use the Find command to find the first occurrence of the search text.
2 Close the Find dialog box.
3 Make whatever changes you want to the search text.
4 Choose Repeat Last Find from the Search menu to find the next occurrence of the search text.

Related Procedure
Keyboard Procedure



Finding and Replacing Text
When you choose the Change command, Write searches for your text forward from the insertion point. 
When it reaches the end of the document, Write automatically continues searching from the beginning of
the document to the insertion point. If you select a section of your document before choosing Change, 
however, the command searches only within the selection.

To find and replace text:
1 Move the insertion point where you want the search to begin.

Or select a block of text to limit the search to a section of the document.
2 Choose Change from the Search menu.
3 Type the search text in the Find What box and the new text in the Change To box.

To search for text that includes tabs, paragraph marks, page breaks, wildcard characters, or spaces, 
use the following characters in the Find What box:

Type To search for
^d A manual page break.
^p A paragraph mark.
^t A tab character.
^w A space character.
? Any character. For example, if you type hea? in the Find What box, Write finds every 

word with hea, such as headstrong, figurehead, heal, heap, or heat.
4 Select the Whole Word check box to find occurrences of the search text that are entire words only.

Otherwise, Write finds, for example, main in remainder.
5 Select the Match Upper/Lowercase check box to match capitalization exactly.

Otherwise, Write finds, for example, both Main and main.
6 Choose one of the following command buttons:

This button Does this
Find Next Finds the next occurrence of the search text. To edit the text in the document,

click the text or press Alt+F6 to switch to the document.
Change, then Find Changes the currently selected search text, and then finds the next 

occurrence. If no text is selected, choosing this option finds the first 
occurrence of the search text.

Change Changes the currently selected search text.
Change All Changes all occurrences of the search text in the document.
Change Selection Changes all occurrences of the search text in the selected section of the 

document. The Change All button is replaced by a Change Selection button if
you select text in your document before choosing the Change command.

Related Procedure
Keyboard Procedure



Going to Specific Pages
To use the Go To Page command, you must first create page breaks by printing or repaginating the 
document.

To go to a specific page:
1 Choose Go To Page from the Search menu.
2 Type the number of the page you want to move to.
3 Click OK.

Related Procedure
Keyboard Procedure



Repaginating Documents
By repaginating a document before printing, you can see where Write automatically places page breaks 
and then you can insert manual page breaks if necessary. Page breaks you insert manually will force a 
new page. You can also make sure that any manual page breaks are still in the right place after you edit 
a document. When Write automatically breaks your document into pages, it prevents a single line in a 
paragraph from being printed by itself at the top or bottom of a page.

To repaginate a document:
1 Choose Repaginate from the File menu.
2 Select the Confirm Page Breaks check box if you want to approve each page break.

If you don't select Confirm Page Breaks, Write shows where page breaks occur, but doesn't allow you
to move the page breaks.

3 Click OK.
Page breaks automatically inserted (by printing or choosing Repaginate) are designated by arrows. 
Page breaks you manually inserted or placed are designated by a dotted line. The page numbers 
appear in the page status area at the lower-left corner of the window.

4 Click Up to move an automatic page break upward a line at a time from Write's proposed location.
Or click Down to move the page break downward a line at a time if you moved it up too far and want 
to move it back.

5 Choose Confirm to move to the next page break.
6 Choose Keep or Remove if you have manually inserted or placed page breaks.

Related Procedure
Keyboard Procedure



Inserting Page Breaks
To insert a page break manually:
1 Position the insertion point where you want the page to break.
2 Press CTRL+ENTER.

You can select, delete, or copy manual pages breaks, just as you can any other character.
Related Procedure
Keyboard Procedure



Inserting Optional Hyphens
You can eliminate large gaps at the end of lines by inserting optional hyphens in long words. Write then 
uses the hyphenation points to break words at the end of a line. Optional hyphens are invisible unless 
they appear in words that break at the end of a line.

To insert optional hyphens:
Press CTRL+SHIFT+HYPHEN at each desired hyphenation point.
Keyboard Procedure



Undoing Your Last Action
To undo your last action:

Choose Undo from the Edit menu.
Keyboard Procedure



Pasting, Copying, and Cutting Pictures
When you paste a picture or graph into Write, it always appears at the left margin. If you paste a picture 
that was created using colors, the colors are converted to black and white. You can select the picture 
and cut, copy, or paste it just as you would text in the document.
Write displays pictures on your screen in a resolution that is appropriate for the default printer. Because 
of differences in screen and printer resolutions, pictures may seem slightly distorted on the screen. 
However, when you print a picture, the resolution will be correct for your printer.

To paste a picture into a Write document:
1 Copy the picture onto the Clipboard.
2 Switch to Write.
3 Open the document you want to paste the picture into.
4 Move the insertion point where you want the picture.
5 Choose Paste from the Edit menu.

To copy or cut a picture:
1 Click the picture to select it.
2 Choose Copy or Cut from the Edit menu.

Related Procedures
Keyboard Procedure



Procedures
Selecting Windows or Icons
Starting Applications



Changing the Size of a Picture
To change the size of a picture:
1 Click the picture to select it.
2 Choose Size Picture from the Edit menu.

A square pointer appears in the center of the picture and a dotted frame surrounds the picture.
3 Place the pointer halfway across the left, right, or bottom edge of the box.

Or place the pointer on a lower corner of the picture box to change both the length and width of the 
picture at the same time.

4 Move the pointer in the direction that you want to enlarge or reduce the picture.
If you are not satisfied with the size of the picture, press ESC to return the picture to its original size.

5 Click the mouse button when the picture box is the size you want.    
If you are not satisfied with the size of the picture, you can choose Undo from the Edit menu.

Related Procedure
Keyboard Procedure



hint
The lower-left corner of the Write window displays sizing information in the form of x and y location 
values. It is best to keep the x and y values the same and to position the frame at whole rather than 
fractional numbers (for example, 5 rather than 5.5). This will prevent distortion of the picture.



Moving Pictures
To move a picture horizontally:
1 Click the picture to select it.
2 Choose Move Picture from the Edit menu.

A square pointer appears in the center of the picture and a dotted frame surrounds the picture.
3 Move the mouse right or left, without pressing a mouse button.

To return the picture box to its original position, press ESC.
4 Click the mouse button when the picture box is located where you want it.

If you are not satisfied with the position of the picture, you can choose Undo from the Edit menu.

To move a picture with formatting commands:
1 Click the picture to select it.

Or press the UP ARROW or DOWN ARROW key to move the insertion point to the picture.
2 Choose Left, Centered, or Right from the Paragraph menu.

Related Procedure
Keyboard Procedure



Changing Character Styles
Choosing one of the Character-menu commands affects the selected text or the next text you type. A 
new paragraph keeps the same character formatting as the previous paragraph. 
Write usually displays the same character formats on screen that will print. If your printer cannot print a 
certain font, point size, or character style, Write attempts to match the selected character format on 
screen as closely as possible.
You can apply more than one style to the same characters. For example, you can bold, italicize, and 
underline the same text. Write maintains the character formats when you move or copy formatted text to 
other parts of the same document or to another Write document.

To apply character styles:
1 Move the insertion point where you want the character style to begin.

Or select the text whose style you want to change.
2 Choose the style you want from the Character menu.

To cancel a character style:
1 Select the text whose style you want to cancel.
2 Choose the style from the Character menu.

Or choose Normal to cancel all styles.
Related Procedure
Keyboard Procedure



Creating Subscript and Superscript Text
Superscript and subscript characters appear slightly above or below other text. They are also scaled to a
smaller size.

To create subscript or superscript text:
1 Move the insertion point where you want subscript or superscript text to begin.

Or select the text that you want to be subscript or superscript.
2 Choose Subscript or Superscript from the Character menu.

Choose Subscript or Superscript again to cancel subscript or superscript text.
Related Procedure
Keyboard Procedure



Changing Fonts and Font Sizes
When you start typing text in a new document, Write uses the standard font for the default printer. With 
commands on the Character menu, you can change to a different font or font size.
To change the font or font size for existing text, you must select the text before you choose the new font 
or size. The Character menu displays a checkmark and the font name if the entire selected region 
contains only one font and font size.

To change the font size with the Font Size commands:
1 Move the insertion point where you want to begin a different font size.

Or select the text you want to change.
2 Choose Reduce Font or Enlarge Font from the Character menu.

Write changes the font size to the next smaller or larger size. If you choose Reduce Font or Enlarge 
Font and the default printer cannot print the next smaller or larger size, the text you type does not 
change size on the screen.

To change fonts from the Character menu:
1 Move the insertion point where you want to begin a different font.

Or select the text you want to change.
2 Choose a font name from the Character menu.

The Character menu contains the names of up to three fonts. If more than three fonts are available, 
you can select them by choosing the Fonts command. If you use the fonts in the Fonts dialog box 
more than those on the Character menu, the font names on the Character menu automatically 
change to the font names you use most often.
If possible, Write displays the same fonts and sizes on the screen that will print. If Write cannot 
exactly match the selected font, it substitutes a font on the screen that resembles the selected font as 
closely as possible.

To change fonts or font sizes with the Fonts command:
1 Move the insertion point where you want to begin a different font.

Or select the text you want to change.
2 Choose Fonts from the Character menu.
3 Select a font name in the Fonts box.

Or type the name of the font in the Font Name box.
The currently selected printer determines which fonts are available. If you plan to print the document 
on a printer other than the currently selected printer, you must set up the printer you want to use. To 
set up a different printer, use Control Panel and then make it the default printer.

4 Select a font size in the Sizes box.
Or type the size in the Point Size box.

5 Click OK.
Related Procedure
Keyboard Procedure



Adding Paragraph Marks
A paragraph mark is not a visible character in a document, but it invisibly marks the end of a paragraph 
or a blank line.

To add a paragraph mark:
1 Press ENTER after typing the last character in a paragraph.
2 Press ENTER again if you want a blank line between paragraphs.

Although Write shows no visible character for the paragraph mark, you can select, delete, copy, and 
move a paragraph mark just as you do other characters.
To select an individual paragraph mark, select the space at the end of a paragraph. Or select both 
text and an individual paragraph mark.
When you copy or move a paragraph, include the paragraph mark in the selection to keep the 
paragraph formats with the paragraph.

To remove a paragraph mark:
1 Move the insertion point to the beginning of the paragraph following the mark you want to remove.
2 Press BACKSPACE.

Or press BACKSPACE twice if your paragraphs have a blank line between them.
Keyboard Procedure



Formatting Paragraphs with the Ruler
Using a mouse, you can change paragraph formats with the Ruler.

To format paragraphs with the Ruler:
1 Choose Ruler On from the Document menu.
2 Place the insertion point anywhere in the paragraph that you want to change.

Or, if you want to format more than one paragraph, select text from the paragraphs.
3 Set the following paragraph format options as appropriate:

To set Do this
Alignment Select one of the four paragraph alignment icons on the right side of the Ruler. 

From left to right, the icons represent alignment to the left margin, centered 
between margins, alignment to the right margin, and justified between margins.

Line spacing Select one of the three line spacing icons in the middle of the Ruler. From left to 
right, icons represent single-spaced, 1 1/2 spaced, and double-spaced.

Indents Drag one of the indent markers to a new position. The left and right indent 
markers are the triangles on the left and right of the Ruler. The first-line indent is 
a small rectangle. The left indent marker and the first-line indent marker are 
superimposed until you move one of them.
You can indent an entire paragraph from the left or right margin, or you can 
indent just the first line of a paragraph from the left margin. Indenting the lines of 
a paragraph differs from changing the left or right margins for a paragraph. Write 
indents paragraph lines from the current margin setting. You should set the 
margins that you want to use for your paper size first (or use the standard 
settings provided by Write) and then indent the paragraphs of your document.

4 Choose Ruler Off from the Document menu if you want to hide the Ruler.
Related Procedure



Changing Paragraph Alignment
You can align a paragraph in any of the following ways:

At the left margin.
At the right margin.
Justified between both margins.
Centered between both margins.

To change paragraph alignment:
1 Place the insertion point anywhere in the paragraph whose alignment you want to change.

Or, if you want to change more than one paragraph, select some text from the paragraphs.
2 Choose Left, Centered, Right, or Justified from the Paragraph menu.

Or choose Normal to align the paragraph at the left margin and make it single-spaced.
Related Procedure
Keyboard Procedure



Changing Paragraph Line Spacing
To change the paragraph line spacing:
1 Place the insertion point anywhere in the paragraph that you want to change.

Or, if you want to change more than one paragraph, select some text from the paragraphs.
2 Choose Single Space, 1 1/2 Space, or Double Space from the Paragraph menu.

Or choose Normal to make the paragraph single-spaced and align the paragraph at the left margin.
Related Procedure
Keyboard Procedure



Changing Paragraph Indents
You can indent an entire paragraph from the left or right margin, or you can indent just the first line of a 
paragraph from the left margin. Indenting the lines of a paragraph differs from changing the left or right 
margins for a paragraph. Write indents paragraph lines from the current margin setting. You should set 
the margins that you want to use for your paper size first (or use the standard settings provided by Write)
and then indent the paragraphs of your document.

To change indentation of a paragraph:
1 Place the insertion point anywhere in the paragraph that you want to change.

Or, if you want to change more than one paragraph, select some text from the paragraphs.
2 Choose Indents from the Paragraph menu.
3 Type a measurement for any indentation you want to change.

The values in the Left Indent and Right Indent boxes specify how far to indent a paragraph from the 
left and right margins. The value in the First Line box indicates how far to indent the first line of the 
paragraph from the rest of the paragraph.

4 Click OK.
Related Procedure
Keyboard Procedure



Creating Hanging Indents
In a paragraph with a hanging indent, the first line extends farther to the left than the rest of the 
paragraph as would happen in a numbered or bulleted list.

To create a hanging indent:
1 Place the insertion point anywhere inside the paragraph that you want to change.

Or, if you want to change more than one paragraph, select some text from the paragraphs.
2 Choose Indents from the Paragraph menu.
3 Enter a positive number in the Left Indent box to set the indentation for the paragraph.

Measurements are in inches or centimeters, depending on the Page Layout setting you choose.
4 Enter a negative number in the First Line box to set the indentation for the first line.
5 Click OK.

Related Procedure
Keyboard Procedure



Changing Page Layout
When you start Write, it uses the following page layout settings:

Measurements in inches.
1-inch top and bottom margins.
1.25-inch side margins.
The first page numbered as 1.

The page layout settings are used in printing.

To change the page layout settings:
1 Choose Page Layout from the Document menu.
2 Type a starting page number for your document in the Start Page Numbers At box to start with a 

number other than 1.
This number appears in your document only if you have a page number in your header or footer.

3 Type margin settings in the Margins boxes.
4 Select inches or centimeters.

The system of measurement you choose is also used for such items as headers, footers, and indents.
5 Click OK.

If you enter a starting page number, Write adjusts the page numbers displayed in the lower-left corner
of the window. Write also uses the adjusted page numbers for the Go to Page command.

Related Procedure
Keyboard Procedure



Adding Headers, Footers, and Page Numbers
You can have one header and one footer in each document. With the Header or Footer commands, you 
can:

Enter the text you want to use as a header or footer.
Include page numbers in the header or footer of the printed document.
Start the header or footer on the first or second page of the document.
Change the distance between the header or footer and the top or bottom of the page.

To add a header or footer:
1 Choose Header or Footer from the Document menu.
2 Type the text for the header or footer in the window.

You can format the text just as you would in any document.
You can move the header or footer (and insertion point) by choosing Centered, Left, or Right from the 
Paragraph menu.
Choose Clear if you make a mistake in the header or footer window and you want to start over again.

3 Click the Insert Page # button if you want to insert page numbers in the document.
4 Select the Print on First Page check box if you want the header or footer to appear on the first page of

the printed document.
Otherwise, the header or footer starts on the second page.

5 Type a measurement in the Distance from Top or Distance from Bottom box if you want to change the
distance between the header or footer and the edge of the page.
Measurements are in inches or centimeters, depending on the Page Layout setting you choose.

6 Choose Return to Document when you finish setting up your header or footer.
When you print your document, you will see your headers and footers, even though they do not 
appear in the main Write window.

Keyboard Procedure



header
Text that appears at the top of every page. A header can include page numbers.



footer
Text that appears at the bottom of every page. A footer can include page numbers.



Changing Tabs with the Ruler
Write has tabs preset at every half inch. You can use these preset tabs to create a column of items 
aligned to the left. Preset tabs do not appear on the Ruler.
Using a mouse with the Ruler, you can set your own tabs for lists or tables. Tabs that you set override 
the preset tabs. You can set up to 12 tabs--either left-aligned tabs or decimal tabs. Decimal tabs let you 
create a column of numbers that line up on their decimal points.

To set tabs:
1 Choose Ruler On from the Document menu.
2 Click one of the two tab icons above the Ruler.

The tab icons are the two icons at the left end of the row of icons above the Ruler.
The tab icon with the period is for decimal tabs.

3 Click the Ruler where you want to set the tab.
Or drag an existing tab marker to a new position.

4 Choose Ruler Off from the Document menu if you want to hide the Ruler.
The tabs you set on the Ruler also appear in the Tabs dialog box.

To remove a tab:
Drag the tab marker off the Ruler.
Related Procedure



Changing Tabs with the Tabs Command
Write has tabs preset at every half inch. You can use these preset tabs to create a column of items 
aligned to the left. Preset tabs do not appear in the Tabs dialog box.
Tabs that you set override the preset tabs. You can set up to 12 tabs--either left-aligned tabs or decimal 
tabs. Decimal tabs let you create a column of numbers that line up on their decimal points.

To set tabs:
1 Choose Tabs from the Document menu.
2 Place the insertion point in a Positions box to add a tab.

Or select a tab measurement in a Positions box to change a tab.
3 Type a measurement.

This is the distance of the tab stop from the left margin.
4 Select the Decimal box if you want a decimal tab.
5 Click OK.

The tabs you set in the Tabs dialog box also appear on the Ruler.

To delete a tab:
1 Choose Tabs from the Document menu.
2 Delete the measurement for the tab.

To delete all tabs at once:
1 Choose Tabs from the Document menu.
2 Choose Clear All.

Write still retains its preset tabs.
Related Procedure
Keyboard Procedure



hint
The text you type at a decimal tab stop is inserted to the left of the tab stop until you type a decimal 
point. The decimal point is inserted at the tab stop, and any additional characters you type are inserted 
to the right of the decimal point. You can use a decimal tab to line up text to the right, as long as you 
don't use more than one period in the text.



Printing Documents
If you have installed and connected to a printer, you can print the current document. Write automatically 
prints to the default printer.

To print the current document:
1 Choose Print from the File menu.
2 Select the print options you want.

This option Does this
Copies Indicates the number of copies to be printed.
Pages: All Prints all the pages in the document.
Pages: From/To Prints a range of pages. After you select this option, type page numbers in the 

From and To boxes.
Draft Quality Prints an unformatted copy of the document text quickly. (Pictures print as empty 

boxes.) If Draft Quality is dimmed, this option is not available for the selected 
printer.

3 Click OK.
When printing, Write uses the margin settings in the Page Layout dialog box.

Related Procedures
Keyboard Procedure



Procedures
Changing Printers and Printer Options
Installing New Printers



Changing Printers and Printer Options
If you have several printers connected to your computer and designated as active printers, you can print 
to one of these printers by selecting it as the default printer.

To change printers:
1 Choose Printer Setup from the File menu.
2 Select the printer that you want to print on.
3 Choose Setup to change printer options.

In the dialog box that appears, the available options depend on the printer you choose.
4 Select the options you want.

For more information on the options, click the Help button in the printer's Setup dialog box.
5 Click OK to close the printer's Setup dialog box.
6 Click OK.

Related Procedure
Keyboard Procedure



Creating New Documents
To create a new document:

Choose New from the File menu.
Related Procedure
Keyboard Procedure



Opening Existing Documents
The size of a file you can open is limited only by the amount of memory available on your computer.

To open a Write document:
1 Choose Open from the File menu.
2 If the file is in the current directory, double-click the name of the file in the Files box.

If the file is not in the current directory, double-click the directory you want in the Directories box. Then
double-click the name of the file in the Files box.    

To open a document that is not in Write format:
1 Choose Open from the File menu.
2 If the file is in the current directory, double-click the name of the file in the Files box.    

If the file is not in the current directory, double-click the directory you want in the Directories box. Then
double-click the name of the file in the Files box.    

3 Choose a conversion option.

This option Opens
No Conversion Text files created with Windows applications, including Write documents saved as

text only.
Most text files created with Windows applications are in ANSI format, the same 
format Write uses. Therefore, you do not need to convert these text files.

Convert Microsoft Word for MS-DOS documents.
Convert Non-Windows application documents saved as text-only.

Most text files created outside of Windows are not in ANSI format. Therefore, you
must convert non-Windows text files.

CAUTION: Be sure you back up a file before you convert it to the Write format. Do not convert any 
files that are not purely text files. In binary files, ASCII characters above 127 might be related to the 
program that created the file and, therefore, cannot be converted. Other files may contain control 
characters that should not be converted.

Related Procedures
Keyboard Procedure



Procedures
Browsing Through the Directories List Box
Creating New Documents



hint
To find files with an extension other than .WRI, type that extension in the Filename box and then click 
OK.



hint
The current directory is shown below the Filename box. Double-clicking the two periods [..] at the top of 
the Directories box shows the files and directories located one level closer to a disk's root directory.
Instead of using the Files and Directories list boxes to open a file, you can type the complete pathname 
in the Filename box and click OK.



hint
If you make a mistake in selecting Convert or No Conversion, simply quit Write without saving the file. 
Your file will be restored to its original status.



Saving Documents
The size of a file you can save is limited only by the amount of memory available on your computer.

To save changes to an existing document:
Choose Save from the File menu.

To save a new Write document or an existing Write document under a different name:
1 Choose Save As from the File menu.
2 If you want to save the file in the current directory, type the filename, including a filename extension if 

you want to specify one.
The .WRI extension is automatically assigned to the filename if you don't specify an extension. If you 
specify an extension, it overrides any automatic extension.
If you want to save the file in a different directory, double-click its name in the Directories box. Then 
type the filename.    

3 Click OK.    

To save a Write document in another format:
1 Choose Save As from the File menu.
2 If you want to save the file in the current directory, type the filename, including a filename extension if 

you want to specify one.
The .DOC extension (for any Word for MS-DOS document) or .WRI extension (for a text-only 
document) is automatically assigned to the filename if you don't specify an extension. If you specify 
an extension, it overrides any automatic extension.
If you want to save the file in a different directory, double-click its name in the Directories box. Then 
type the filename.    

3 Select Text Only and/or Microsoft Word Format.
You lose all graphics and formatting when saving a document in text or Word format.

This format Saves your document as
Text Only A Windows ANSI text file. You might want to use this option if your document 

is a program or will be telecommunicated.
Microsoft Word A Microsoft Word for MS-DOS document.
Text Only and Word An unformatted Microsoft Word for MS-DOS text file.

4 Click OK.    
Related Procedures
Keyboard Procedure



Procedures
Browsing Through the Directories List Box
Making Backup Copies



hint
The current directory is shown below the Filename box. Double-clicking the two periods [..] at the top of 
the Directories box shows the directories located one level closer to a disk's root directory.



hint
Instead of using the Files and Directories list boxes to save a file, you can type the complete pathname 
in the Filename box and click OK.



Making Backup Copies
To make a backup copy of a document:
1 Choose Save As from the File menu.
2 If you want to save the file in the current directory, type the filename, including a filename extension if 

you want to specify one.
If you want to save the file in a different directory, double-click its name in the Directories box. Then 
type the filename.    

3 Select Make Backup.
4 Select Text Only and/or Microsoft Word Format if you want to specify a format.
5 Click OK.

Backup Copy Extensions
When making a backup, if you do not change the filename extension, Write automatically assigns the 
following extensions to the backup copy:

Document Format Backup Copy Extension
Windows Write .BKP
Microsoft Word .BAK
If you delete the filename extension of a Write document and save it in Microsoft Word for MS-DOS 
format, the document and its backup are given the following extensions:

.DOC for the document now in Word for MS-DOS format.

.WRI for the backup copy. This is the original version of the document in Write format.
Similarly, if you delete the filename extension of an existing Word for MS-DOS document and save it in 
Write format, the document and its backup are given the following extensions:

.WRI for the document now in Write format.

.DOC for the backup copy. This is the original version of the document in Word for MS-DOS 
format.

Related Procedures
Keyboard Procedure
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Optional Hyphen Keys
Page Break Keys
Picture Keys
Text Selection Keys



Movement Keys
Use the following keys to move the insertion point:

To move the insertion point Press

Up one line UP ARROW

Down one line DOWN ARROW

Right one character RIGHT ARROW

Left one character LEFT ARROW

Right one word CTRL+RIGHT 
ARROW

Left one word CTRL+LEFT ARROW

To the beginning of the line HOME

To the end of the line END

To the next sentence 5+RIGHT ARROW

To the previous sentence 5+LEFT ARROW

To the next paragraph 5+DOWN ARROW

To the previous paragraph 5+UP ARROW

To the next page, according to the last 
repagination

5+PAGE DOWN

To the previous page, according to the last 
repagination

5+PAGE UP

Up one window PAGE UP

Down one window PAGE DOWN

To the beginning of the document CTRL+HOME

To the end of the document CTRL+END

Use the following keys to move between some Write dialog boxes and the document:

To switch Press

Between the document and the Find or 
Change dialog box

ALT+F6

Between the document and the Page Header
or Page Footer dialog box

ALT+F6

Optional Hyphen Keys

To insert Press

An optional hyphen CTRL+SHIFT+HYPHE
N

Page Break Keys

To insert Press



A page break CTRL+ENTE
R

Picture Keys

To Press

Select a picture. SHIFT+RIGHT 
ARROW

Move the Size Picture cursor.
Move a selected picture after you choose 
Move Picture.

arrow keys

Text Selection Keys

To select text Press

One character at a time to the left or right.
Or, if the character is already selected, to 
cancel the selection.

SHIFT+LEFT or RIGHT 
ARROW

Up or down one line at a time. Or, if the 
line is already selected, to cancel the 
selection.

SHIFT+DOWN or UP ARROW

Up one window. Or, if the previous 
window is already selected, to cancel the 
selection.

SHIFT+PAGE UP

Down one window. Or, if the next window 
is already selected, to cancel the 
selection.

SHIFT+PAGE DOWN

To the beginning of the line. SHIFT+HOME

To the end of the line. SHIFT+END

To the previous word. CTRL+SHIFT+LEFT ARROW

To the next word. CTRL+SHIFT+RIGHT ARROW

To the next paragraph. SHIFT+5+DOWN ARROW

To the previous paragraph. SHIFT+5+UP ARROW

To the beginning of the document. CTRL+SHIFT+HOME

To the end of the document. CTRL+SHIFT+END



          Editing a Document  
          Editing a Picture  
          Formatting Text  
          Formatting a Document  
          Printing  
          Working with Documents  



          Editing a Document  
Moving the Insertion Point
Selecting Text
Copying and Moving Text
Finding Text
Finding and Replacing Text
Going to Specific Pages
Repaginating Documents
Inserting Page Breaks
Inserting Optional Hyphens
Undoing Your Last Action

          Editing a Picture  
          Formatting Text  
          Formatting a Document  
          Printing  
          Working with Documents  



          Editing a Document  
          Editing a Picture  

Pasting, Copying, and Cutting Pictures
Changing the Size of a Picture
Moving Pictures

          Formatting Text  
          Formatting a Document  
          Printing  
          Working with Documents  



          Editing a Document  
          Editing a Picture  
          Formatting Text  

Changing Character Styles
Creating Subscript and Superscript Text
Changing Fonts and Font Sizes
Adding Paragraph Marks
Changing Paragraph Alignment
Changing Paragraph Line Spacing
Changing Paragraph Indents
Creating Hanging Indents

          Formatting a Document  
          Printing  
          Working with Documents  



          Editing a Document  
          Editing a Picture  
          Formatting Text  
          Formatting a Document  

Changing Page Layout
Adding Headers, Footers, and Page Numbers
Changing Tabs with the Tabs Command

          Printing  
          Working with Documents  



          Editing a Document  
          Editing a Picture  
          Formatting Text  
          Formatting a Document  
          Printing  

Printing Documents
Changing Printers and Printer Options

          Working with Documents  



          Editing a Document  
          Editing a Picture  
          Formatting Text  
          Formatting a Document  
          Printing  
          Working with Documents  

Creating New Documents
Opening Existing Documents
Saving Documents
Making Backup Copies



Keyboard: Moving the Insertion Point
To move the insertion point:

Use the following keys:

Press To move the insertion point
UP ARROW Up one line.
DOWN ARROW Down one line.
RIGHT ARROW Right one character.
LEFT ARROW Left one character.
CTRL+RIGHT ARROW Right one word.
CTRL+LEFT ARROW Left one word.
HOME To the beginning of the line.
END To the end of the line.
5+RIGHT ARROW To the next sentence.
5+LEFT ARROW To the previous sentence.
5+DOWN ARROW To the next paragraph.
5+UP ARROW To the previous paragraph.
5+PAGE DOWN To the next page, according to the last repagination.
5+PAGE UP To the previous page, according to the last repagination.
PAGE UP Up one window.
PAGE DOWN Down one window.
CTRL+HOME To the beginning of the document.
CTRL+END To the end of the document.

Mouse Procedure



Keyboard: Selecting Text
To select text:
1 Move the insertion point to the first character you want to select.
2 Press SHIFT.
3 Move the insertion point to the last character you want to select.
4 Release SHIFT.

To cancel a selection:
Press an arrow key.
Mouse Procedure



Keyboard: Copying and Moving Text
To copy or move text:
1 Select the text you want to copy or move.
2 Press CTRL+INS to copy the selected text.

Or press SHIFT+DEL to move the selected text.
3 Move the insertion point where you want to paste the text.
4 Press SHIFT+INS.

Related Keys
Mouse Procedure



Keyboard: Finding Text
To find text:
1 Move the insertion point where you want to start your search.
2 Press ALT and then S.
3 Press F.
4 Type the search text in the Find What box.
5 Press ALT+W to find occurrences of the search text that are entire words only.
6 Press ALT+M to match capitalization exactly.
7 Press ENTER to start the search.
8 Press ENTER again to find the next occurrence of the search text.

Or press ESC to close the Find dialog box and press F3 to find the next occurrence of search text 
without opening the Find dialog box.

Related Procedure
Mouse Procedure



Keyboard: Finding and Replacing Text
To find and replace text:
1 Move the insertion point where you want to start your search.

Or select a block of text to limit the search to a section of the document.
2 Press ALT and then S.
3 Press C.
4 Type the search text in the Find What box.
5 Press TAB and type the new text in the Change To box.
6 Press ALT+W to find occurrences of the search text that are entire words only.
7 Press ALT+M to match capitalization exactly.
8 Press ALT+N (Find Next), ALT+H (Change, then Find), ALT+A (Change All), ALT+C (Change), or ALT+S 

(Change Selection).
Related Topics
Mouse Procedure



Keys
Text Selection Keys

Procedures
Finding Text



Keyboard: Going to Specific Pages
To go to a specific page:
1 Press F4.
2 Type the number of the page you want to move to.
3 Press ENTER.

Related Procedure
Mouse Procedure



Keyboard: Repaginating Documents
To repaginate a document:
1 Press ALT and then F.
2 Press E.
3 Press ALT+B to approve each page break during pagination.
4 Press ENTER.
5 Press ALT+U to move an automatic page break upward a line at a time from Write's proposed location.

Or press ALT+D to move the page break downward a line at a time if you moved it up too far and want 
to move it back.

6 Press ALT+C to move to the next page break.
7 Press ALT+K to keep a manually inserted or placed page break.

Or press ALT+R to remove a manually inserted or placed page break.
Related Procedure
Mouse Procedure



Keyboard: Inserting Page Breaks
To insert a page break manually:
1 Move the insertion point where you want the page to break.
2 Press CTRL+ENTER.

Related Procedure
Mouse Procedure



Keyboard: Inserting Optional Hyphens
To insert optional hyphens:

Press CTRL+SHIFT+HYPHEN at each desired hyphenation point.
Mouse Procedure



Keyboard: Undoing Your Last Action
To undo your last action:

Press ALT+BACKSPACE.
Mouse Procedure



Keyboard: Pasting, Copying, and Cutting Pictures
To paste a picture into a Write document:
1 Copy the picture onto the Clipboard.
2 Switch to Write.
3 Open the document you want to paste the picture into.
4 Move the insertion point    where you want to insert the picture.
5 Press SHIFT+INS.

To copy or cut a picture:
1 Move the insertion point to the picture to select it.
2 Press CTRL+INS to copy the picture.

Or press SHIFT+DEL to cut the picture.
Related Procedures
Mouse Procedure



Procedures
Selecting Windows or Icons
Starting Applications



Keyboard: Changing the Size of a Picture
To change the size of a picture:
1 Move the insertion point to the picture to select it.
2 Press ALT and then E.
3 Press S.
4 Use the arrow keys to move the pointer until it rests halfway across the left, right, or bottom edge of 

the box.
Or move the pointer to a lower corner of the picture box.

5 Move the pointer in the direction that you want to enlarge or reduce the picture.
6 Press ENTER when the picture box is the size you want.

Related Procedure
Mouse Procedure



Keyboard: Moving Pictures
To move a picture horizontally:
1 Move the insertion point to the picture to select it.
2 Press ALT and then E.
3 Press M.
4 Press the LEFT ARROW or RIGHT ARROW key.
5 Press ENTER when the picture box is located where you want it.

Related Procedure
Mouse Procedure



Keyboard: Changing Character Styles
To apply character styles:
1 Move the insertion point where you want the character style to begin.

Or select the text whose style you want to change.
2 Press CTRL+B (Bold), CTRL+I (Italic), or CTRL+U (Underline).

To cancel a character style:
1 Select the text whose style you want to cancel.
2 Press CTRL+B (Bold), CTRL+I (Italic), or CTRL+U (Underline) to cancel one style.

Or press F5 to cancel all styles.
Related Topics
Mouse Procedure



Keys
Text Selection Keys

Procedure
Creating Subscript and Superscript Text



Keyboard: Creating Subscript and Superscript Text
To create subscript or superscript text:
1 Move the insertion point where you want subscript or superscript text to begin.

Or select the text that you want to be subscript or superscript.
2 Press ALT and then E.
3 Press P to choose Superscript.

Or press C to choose Subscript
Related Topics
Mouse Procedure



Keys
Text Selection Keys

Procedure
Changing Character Styles



Keyboard: Changing Fonts and Font Sizes
To change fonts or font sizes from the Character menu:
1 Move the insertion point where you want to make a font change.

Or select the text you want to change.
2 Press ALT and then C.
3 Press the number associated with the font you want on the Character menu.

Or press R (Reduce Font) or E (Enlarge Font) to change the font size.

To change fonts or font sizes with the Fonts command:
1 Move the insertion point where you want to make a font change.

Or select the text you want to change.
2 Press ALT and then C.
3 Press F.
4 Type a font name in the Font Name box.

Or press TAB and use the UP ARROW or DOWN ARROW to select a font.
5 Press TAB and use the UP ARROW or DOWN ARROW to select a font size.

Or press ALT+P and type the size in the Point Size box.
6 Press ENTER.

Related Keys
Mouse Procedure



Keyboard: Adding Paragraph Marks
To add a paragraph mark:
1 Press ENTER after typing the last character in a paragraph.
2 Press ENTER again if you want a blank line between paragraphs.

To remove a paragraph mark:
1 Move the insertion point to the beginning of the paragraph following the mark you want to remove.
2 Press BACKSPACE.

Or press BACKSPACE twice if your paragraphs have a blank line between them.
Mouse Procedure



Keyboard: Changing Paragraph Alignment
To change paragraph alignment:
1 Move the insertion point anywhere in the paragraph that you want to change.

Or, if you want to change more than one paragraph, select some text from the paragraphs.
2 Press ALT and then P.
3 Press L (Left), C (Centered), R (Right), or J (Justified).

Or press N (Normal) to align the paragraph at the left margin and make it single-spaced.
Related Keys
Mouse Procedure



Keyboard: Changing Paragraph Line Spacing
To change the paragraph line spacing:
1 Move the insertion point anywhere in the paragraph that you want to change.

Or, if you want to change more than one paragraph, select some text from the paragraphs.
2 Press ALT and then P.
3 Press S (Single Space), 1 (1 1/2), or D (Double Space).

Or press N (Normal) to make the paragraph single-spaced and align the paragraph at the left margin.
Related Keys
Mouse Procedure



Keyboard: Changing Paragraph Indents
To change indentation of a paragraph:
1 Move the insertion point anywhere in the paragraph that you want to change.

Or, if you want to change more than one paragraph, select some text from the paragraphs.
2 Press ALT and then P.
3 Press I.
4 Press TAB until you select a measurement for an indentation you want to change.
5 Type a measurement.
6 Press ENTER.

Related Keys
Mouse Procedure



Keyboard: Creating Hanging Indents
To create a hanging indent:
1 Move the insertion point anywhere inside the paragraph that you want to change.

Or, if you want to change more than one paragraph, select some text from the paragraphs.
2 Press ALT and then P.
3 Press I.
4 Type a positive number in the Left Indent box to set the indentation for the paragraph.
5 Press TAB and type a negative number in the First Line box to set the indentation for the first line.
6 Press ENTER.

Related Keys
Mouse Procedure



Keyboard: Changing Page Layout
To change the page layout:
1 Press ALT and then D.
2 Press P.
3 Type a starting page number for your document in the Start Page Numbers At box to start with a 

number other than 1.
4 Press TAB until you select a margin you want to change. Then type the margin setting.
5 Press ALT+I to select inches or press ALT+C to select centimeters.
6 Press ENTER.

Related Procedure
Mouse Procedure



Keyboard: Adding Headers, Footers, and Page Numbers
To add a header or footer:
1 Press ALT and then D.
2 Press H (Header) or F (Footer).
3 Type the text for the header or footer in the window. Then press ALT+F6 to switch to the Page Header 

or Page Footer dialog box.
Press ALT+C if you made a mistake in the header or footer window and you want to start over again.

4 Press ALT+I to insert page numbers in the document.
5 Press ALT+P to select the Print on First Page check box if you want the header or footer to appear on 

the first page of the printed document.
6 Press ALT+D and type a measurement in the Distance from Top or Distance from Bottom box if you 

want to change the distance between the header or footer and the edge of the page.
7 Press ALT+R when you finish setting up your header or footer.

Mouse Procedure



Keyboard: Changing Tabs with the Tabs Command
To change tabs:
1 Press ALT and then D.
2 Press T.
3 Press TAB until the insertion point reaches a Positions box in which you want to add a tab.

Or press TAB until you select a tab measurement you want to change.
4 Type a measurement. Then press TAB and press the SPACEBAR if you want a decimal tab.

Or press BACKSPACE to delete a tab.
Or press ALT+A to delete all tabs at once.

5 Press ENTER.
Mouse Procedure



Keyboard: Printing Documents
To print the current document:
1 Press ALT and then F.
2 Press P.

3 Type the number of copies you want.
4 Press ALT+A to print all the pages of the document.

Or press ALT+F to print some of the pages of the document. Then type the starting page number, and 
press TAB and type the ending page number.

5 Press ALT+D if you want to print in draft quality.
6 Press ENTER.

Related Procedure
Mouse Procedure



Keyboard: Changing Printers and Printer Options
To change printers:
1 Press ALT and then F.
2 Press R.
3 Use the UP ARROW or DOWN ARROW to select the printer that you want.
4 Press ALT+S to change printer options.
5 Select the options you want and press ENTER.
6 Press ENTER.

Mouse Procedure



Keyboard: Creating New Documents
To create a new document:
1 Press ALT and then F.
2 Press N.

Related Procedure
Mouse Procedure



Keyboard: Opening Existing Documents
To open a document:
1 Press ALT and then F.
2 Press O.
3 If the file is in the current directory, press ALT+F and use the UP ARROW or DOWN ARROW key to select 

the file.
If the file is not in the current directory,press ALT+D, use the UP ARROW or DOWN ARROW key to select a 
drive or directory, and press ENTER. Then press ALT+F and use the UP ARROW or DOWN ARROW key to 
select the file.    

4 Press ENTER.    
5 Press ALT+C (Conversion), ALT+N (No Conversion), or ESC (Cancel) if you are opening a document not 

in Write format.
Related Procedures
Mouse Procedure



Procedures
Browsing Through the Directories List Box
Creating New Files



hint
The current directory is shown below the Filename box. Choosing the two periods [..] at the top of the 
Directories box shows the files and directories located one level closer to a disk's root directory.
To find files with an extension other than .WRI, type that extension in the Filename box. Then press 
ENTER.



hint
Instead of using the Files and Directories list boxes to open a file, you can type the complete pathname 
in the Filename box and press ENTER.



Keyboard: Saving Documents
To save changes to an existing document:
1 Press ALT and then F.
2 Press S.

To save a new document or an existing document under a different name:
1 Press ALT and then F.
2 Press A.
3 If you want to save the file in the current directory, type the filename, including a filename extension if 

you want to specify one.
If you want to save the file in a different directory, press ALT+D and use the UP ARROW or DOWN ARROW 
key to select a directory, and press ENTER. Then press ALT+N and type the filename.    

4 Press ENTER.    

To save a Write document in another format:
1 Press ALT and then F.
2 Press A.
3 If you want to save the file in the current directory, type the filename, including a filename extension if 

you want to specify one.
If you want to save the file in a different directory, press ALT+D and use the UP ARROW or DOWN ARROW 
key to select a directory, and press ENTER. Then press ALT+N and type the filename.    

4 Press ALT+T if you want the document saved as text only.
5 Press ALT+W if you want the document saved in Microsoft Word for MS-DOS format.
6 Press ENTER.    

Related Procedures
Mouse Procedure



Procedures
Browsing Through the Directories List Box
Making Backup Copies



hint
The current directory is shown below the Filename box. Choosing the two periods [..] at the top of the 
Directories box shows the directories located one level closer to a disk's root directory.



hint
Instead of using the Files and Directories list boxes to save a file, you can type the complete pathname 
in the Filename box and press ENTER.



Keyboard: Making Backup Copies
To make a backup copy of a document:
1 Press ALT and then F.
2 Press A.
3 If you want to save the file in the current directory, type the filename, including a filename extension if 

you want to specify one.
If you want to save the file in a different directory, press ALT+D and use the UP ARROW or DOWN ARROW 
key to select a directory, and press ENTER. Then press ALT+N and type the filename.    

4 Press ALT+M to select Make Backup.
5 Press ALT+T if you want the document saved as text only.
6 Press ALT+W if you want the document saved in Microsoft Word for MS-DOS format.
7 Press ENTER.    

Related Procedures
Mouse Procedure



Procedures
Browsing Through the Directories List Box
Saving Documents







Write
A word-processing application you can use to create and print documents.



application Control-menu



title bar          
Contains the title of the application running in the window, in this case Write. The title bar also shows the
name of the file that's open.

Drag the title bar to move an application window on the screen.



Minimize button          
Click the Minimize button to shrink the Write window to an icon.



Maximize button          
Click the Maximize button to enlarge the Write window to its maximum size.



File Menu



Edit Menu



Search Menu



Character Menu



Paragraph Menu



Document Menu



Help Menu



menu bar          
Contains the names of all the Write menus.

Click a menu name to display the menu commands.



scroll arrow          

An arrow on either end of a scroll bar used to move the contents of the window or list box.
Click a scroll arrow to move the contents.



scroll bar          
A bar that appears at the right and/or bottom edge of a window whose contents aren't completely visible.
Each scroll bar contains two scroll arrows and a scroll box, which allow you to move the contents of the 
window or list box.

Click a scroll bar to move the contents one screen.



scroll box          

A small box in a scroll bar. The scroll box shows the position of what's currently in the window or list box 
relative to the contents of the entire file or list.

Drag the scroll box to display another part of the contents.



Ruler          
Displayed across the top of the window when you choose the Ruler On command from the Document 
menu. Use the Ruler to view and apply paragraph formatting.



left tab icon          

Sets a left-aligned tab. Characters are inserted to the right of the tab stop.
Select the icon and then click the Ruler where you want the tab to appear.



decimal tab icon          

Sets a decimal tab.
When you type text at a decimal tab stop, the characters you type are inserted to the left of the tab stop 
until you type a decimal point. The decimal point is inserted at the tab stop, and any additional 
characters you type are inserted to the right of the decimal point.

Select the icon and then click the Ruler where you want the tab to appear.



single space icon          

Formats paragraphs single spaced.
Click the icon to format selected paragraphs or a paragraph in which the insertion point appears.



1 1/2 space icon          

Changes line spacing of paragraphs to 1 1/2 spaces.
Click the icon to format selected paragraphs or a paragraph in which the insertion point appears.



double space          

Formats paragraphs double spaced.
Click the icon to format selected paragraphs or a paragraph in which the insertion point appears.



left aligned icon          

Aligns paragraphs or pictures with the left margin.
Click the icon to format a selected paragraph or picture, or a paragraph in which the insertion 

point appears.



centered icon          

Centers paragraphs or pictures between the left and right margins.
Click the icon to format a selected paragraph or picture, or a paragraph in which the insertion 

point appears.



right aligned icon          

Aligns paragraphs or pictures with the right margin.
Click the icon to format a selected paragraph or picture, or a paragraph in which the insertion 

point appears.



justified icon          

Aligns paragraphs with both the left and right margins.
Click the icon to format a selected paragraph or picture, or a paragraph in which the insertion 

point appears.



left indent marker          first line indent marker          

left indent marker indents paragraphs from the left margin.
first line indent marker indents the first line of paragraphs. By default, the first line indent marker 

appears as a small white square on top of the left indent marker.
Drag the left indent marker to change the indent of selected paragraphs, or a paragraph in which 

the insertion point appears.
Drag the first line indent marker to change the indent of the first line in selected paragraphs, or a 

paragraph in which the insertion point appears.



right indent marker          
Indents paragraphs from the right margin.

Drag the right indent marker to change the indent of selected paragraphs, or a pagraph in which 
the insertion point appears.



text          
Text you type appears in the Write window.

Place the insertion point where you want text to appear and start typing.



selected text          
Text that is highlighted with key combinations or with the mouse. You select text before carrying out an 
action such as copying the text or changing its character formatting.

Point to the first character you want to select, drag the pointer, and let go of the mouse button at 
the last character you want to select.



insertion point          
The place where text will be inserted when you type. The insertion point appears as a flashing vertical 
bar in the Write window. The text you type appears to the left of the insertion point, which is pushed to 
the right as you type.

Click the mouse pointer in a body of text to move the insertion point.



picture          

Example of a picture that has been created in another Windows application and pasted into this Write 
document.

Click the picture to select it.



mouse pointer          
The cursor on the screen that follows the mouse's movement and indicates which area of the screen will
be affected when you click the mouse's button. The pointer appears as an I-beam when it's over text and
as a pointer when it's in the selection area.

Move the mouse to move the pointer.



selection area
Invisible area that extends vertically along the left margin of the Write window. Use the selection area to 
select blocks of text. The mouse pointer slants to the right when it is in the selection area.



document end marker          
Marks the end of the document.



manual page break          

A page break you insert.
Page breaks divide one printed page from another. A manual page break is marked by a dotted line 
whereas an automatic page break is marked by double arrows at the left edge of the window.

Press CTRL+ENTER to insert a page break.



automatic page break          

Page break inserted when you print or choose the Repaginate command from the File menu.
Page breaks divide one printed page from another. An automatic page break is marked by double 
arrows at the left edge of the window whereas a manual page break is marked by a dotted line.

Choose Repaginate from the File menu to view or change automatic page breaks.



page status area          

Shows the page number of the text appearing at the top of the window.
Choose Repaginate from the File menu to view pagination in your document.



application window
The main window for an application, in this case the Write window. It contains the application's menu bar
and main workspace. The Write application window can contain text or graphics.



window border          
The outside edge of a window.

Drag the window border to change the size of the window.







A
386 enhanced mode
active
active printer
animation
application
application icon
application window
arrow keys
associate
AUTOEXEC.BAT



B
<< button
>> button
Back button
base-level synthesizer
batch file
baud rate
bitmap
branch
browse
byte



C
cascading menu complementary color
CD-ROM compound device
channel CONFIG.SYS
check box Contents button
choose Control menu
Clipboard Control-menu box
close conventional memory
collapse cutout
command
command button
command line



D
data bits Directory Tree window
default button directory window
default printer disk-drive icon
desktop display box
desktop pattern document
destination directory document file
device contention document window
device driver DOS
dialog box drag
directory path drop-down list box
Directory Tree



E
error-checking
expand
expanded memory
extended memory
extended synthesizer
extension



F
file
file information line
flow control
font
font size
format
full-screen application



G
General MIDI Mode standard
group
group icon
group window



H
History button
hotspot
hue
HyperGuide button bar



I
icon
insertion point
International MIDI Association



J
No defined terms.



K
keymaps
keyword
kilobyte



L
list box
local printer
local queue
luminosity



M
maximize MIDI Mapper
Maximize button MIDI sequencer
Media Control Interface MIDI Manufacturer's Association (MMA)
memory minimize
menu Minimize button
menu bar movie file
menu command MSCDEX
menu name multimedia extensions
menu title Multimedia PC
MIDI multitasking
MIDI file



N
network printer
network queue
network server
non-Windows application



O
open
option button



P
parity print option
palette printer-driver file
patch printer font
patchmaps printer queue information line
pathname program file
picture elements program information file (PIF)
pixels program item
playlist program item icon
pointer
port



Q
No defined terms.



R
RGB components
read-only
real mode
Restore button
root directory



S
sample serial port
saturation shortcut key
scaled font size shrink
screen font simple device
screen saver solid color
scroll arrow source directory
scroll bar spin box
scroll box standard mode
Search button status bar
select stop bits
selection cursor synthesizer



T
Task List
text box
text file
title
title bar
topic
track



U
Up button



V
vector font
virtual memory
volume label



W
waveform
WAVE format
wildcard characters
window
window border
Windows application
wrap



X
No defined terms.



Y
No defined terms.



Z
No defined terms.



386 enhanced mode
Provides access to the virtual memory capabilities of the Intel 80386 processor. With virtual memory 
capabilities, Windows applications can use more memory than is physically available. Enhanced mode 
also allows for multitasking of non-Windows applications.



active
Describes the selected window or icon that you are currently working with. Windows always applies the 
next keystroke or command you choose to the active window. If a window is active, it appears in front of 
all other windows on the desktop, and its title bar changes color to differentiate it visually from other 
windows. If an icon is made active, its Control menu appears.
Inactive is the opposite of active and describes windows or icons on the desktop that are not selected.



active printer
An installed printer that has been assigned to a printer port using Setup or Control Panel. More than one
printer can be set up to work on a single port, but only one can be active, since only one printer can be 
physically connected to the port at a time.
An inactive printer is an installed printer that is not currently connected to the printer port.



animation
The display of a series of graphic images, simulating motion. You can play animation files (for example, 
files with the.MMM extension) with the Media Player accessory. Animations are also called movies.



application
A computer program used for a particular kind of work, such as word processing. This term is often used
interchangeably with "program."



application icon          

An icon that represents an application that is running.



application window
The main window for an application. It contains the application's menu bar and main workspace. An 
application window may contain multiple document windows.



arrow keys          

The four arrow keys on your computer keyboard. These keys move the cursor or pointer on your screen 
to locations you choose. Each arrow key moves the cursor or pointer in the direction of the arrow on the 
key. Each arrow key is named for the direction in which arrow points: UP ARROW, DOWN ARROW, LEFT 
ARROW, and RIGHT ARROW.



associate
To assign files that have the same extension to a program. When you choose a file with the specified 
extension, the associated application runs with the file loaded.



AUTOEXEC.BAT
Batch file that lists MS-DOS commands. MS-DOS automatically carries out the commands in your 
AUTOEXEC.BAT file when you turn on your computer. The file is located in the root directory of your first
hard disk, which is usually drive C.
Typically, an AUTOEXEC.BAT file starts memory-resident utilities such as a network and sets up 
environment variables that are used later by applications. In addition, your AUTOEXEC.BAT file might 
set your MS-DOS prompt or start pop-up programs such as Borland's SideKick.



<< button          

Displays the previous topic in a series of topics, until you reach the first topic in the series. Then the 
button is dimmed. Use this button when you want to backtrack through topics the way they are 
organized in HyperGuide.



>> button          

Displays the next topic in a series of topics, until you reach the last topic in the series. Then the button is
dimmed. Use this button to move from topic to topic in the recommended order.



Back button          

Displays the last topic you viewed. HyperGuide moves back one topic at a time, in the order in which 
you viewed them.



base-level synthesizer
One of the two types of synthesizers accommodated by Windows.
MIDI files authored for Windows include two versions of a song: one version for base-level synthesizers 
and another version for extended synthesizers. The distinctions between base-level and extended 
synthesizers are based on the number of instruments and notes the synthesizer can play.



batch file
A file that runs a sequence, or "batch," of commands when you type its filename. All filenames of batch 
files end with the extension .BAT, even though you don't have to type this extension to run the batch file.



baud rate
Signalling speed measured by the number of signals per second.



bitmap          

An image stored as an array of bits.



branch          

A segment of the Directory Tree, representing a directory and any subdirectories it contains.



browse
To look through files and directories. In some dialog boxes, the Browse button shows a list of files and 
directories from which you can choose.



byte
The amount of memory space (normally 8 bits) that a computer needs to represent a single character or 
word.



cascading menu          

A menu that opens from a command on another menu.



CD-ROM
Compact Disc-Read Only Memory. An optical data-storage technology that allows large quantities of 
data (such as animations, images, music, and sound) to be stored on a compact disc similar to discs 
used by the music industry.



channel
MIDI uses channels to send messages to individual devices within a MIDI setup. There are 16 MIDI 
channel numbers. Devices in a MIDI setup can be directed to respond only to messages marked with a 
channel number specific to the device.



check box           

A small square box that appears in dialog boxes and can be selected or cleared. When the check box is 
selected, an X appears in the box.



choose
To use key combinations or your mouse to carry out a command in Windows. You often choose a 
command after you have selected an item or made it active.



Clipboard          

A temporary storage area in memory, used to transfer information. You can cut or copy information onto 
the Clipboard and then paste it into another document or application.



close
To reduce a document window or application window to an icon or, in some cases, to remove it from the 
desktop. You close a window by double-clicking the Control-menu box or choosing the Close command 
from the Control menu. When closing an application window, you can choose to save or abandon 
changes to the current document before you close it.



collapse
To hide a level of directory information in the Directory Tree window. When you first start File Manager, 
all directories but the root directory are collapsed.



command          

A word or phrase, usually found in a menu, that you choose to carry out an action.



command button          

A button in a dialog box that carries out or cancels the selected action. Two common command buttons 
are OK and Cancel. The button that carries out the action will often have a label that describes it (for 
example, Open, Create, Install). Another dialog box appears when you choose a command followed by 
ellipses.



command line
Information given to MS-DOS that specifies a command and all the pertinent information to carry it out. 
For example, to start Windows, you type win at the MS-DOS prompt.



complementary color
The color exactly opposite a color on the RGB color wheel. For example, the complementary color of 
blue is yellow.



compound device
Devices, such as the waveform audio driver, that have an associated file and require a filename 
specification when opened.



CONFIG.SYS
A file that defines device drivers and specifies your MS-DOS configuration. For example, a typical 
CONFIG.SYS file might specify the location of the MS-DOS file COMMAND.COM, define an extended 
memory manager, and specify how many files an application can have open at once. MS-DOS runs the 
commands in the CONFIG.SYS file each time you turn on your computer. Your CONFIG.SYS file is 
located in the root directory of your first hard disk, which is usually drive C.



Contents button          

Displays the HyperGuide contents.



Control menu          

The menu in the upper-left corner of a window. The Control menu appears on every application that runs
in a window and on some non-Windows applications. Document windows, icons, and some dialog boxes
also have Control menus.
Control menu commands move, change the size of, and close windows. You can also switch to Task List
by using the Control menu. For non-Windows applications, Control menu commands transfer 
information and perform other functions, depending on the application.



Control-menu box
The box located in the upper-left corner of a window. Clicking the Control-menu box opens the Control 
menu for the window.



conventional memory
The first 640K of memory that MS-DOS uses to run applications. Most computers have at least 256K of 
conventional memory and can accommodate up to 640K of conventional memory.



cutout          
A portion of a Paintbrush drawing you select with the Scissors or Pick tool.



data bits
The bits in each package of data sent between two computers during telecommunication. Most 
characters are transmitted in 7 or 8 data bits.



default button          

The command button in some dialog boxes that is automatically selected or chosen by Windows as the 
most logical or safest choice. The default button has a bold border, indicating that it will be chosen if you 
press ENTER. You can override a default button by choosing Cancel or another command button.



default printer
The printer that Windows applications automatically use when you choose the Print command. You can 
have only one default printer, which must also be the active printer on the port. The printer you use most 
often should be made the default printer.



desktop
The background of your screen, on which windows, icons, and dialog boxes appear.



desktop pattern
A geometric pattern that appears across your desktop. You can design your own pattern or choose one 
of the patterns provided by Windows.



destination directory
The directory to which you intend to copy or move one or more files.



device contention
When several applications simultaneously request use of a peripheral device, such as a printer or 
modem.
Windows automatically handles device contention when all the applications are Windows applications. 
When one of the applications is a non-Windows application, however, the conflict is handled according 
to the options you select in the 386 Enhanced dialog box. This dialog box appears when you choose the 
386 Enhanced icon in Control Panel.



device driver
Tells Windows how to control a piece of hardware. Using Control Panel, you can install device drivers for
your:

Display (monitor)
Keyboard
Mouse
Network



dialog box          

A rectangular box that either requests or provides information. Many dialog boxes present options that 
you must choose from before Windows can carry out a command. Some dialog boxes present warnings 
or explain why a command can't be completed.



directory path          

The directions to a directory or file within your system.
In the illustration, C:\ART stands for the ART directory on drive C. Any commands you use affect the files
and subdirectories in this directory.
When you want to specify a file, make sure the filename follows the directory path.



Directory Tree          

A graphic display of a disk's directory structure. The directories on the disk are shown as branching from
the disk's root directory.



Directory Tree window          

A File Manager window that shows the complete branching structure of the selected disk drive.



directory window          

A File Manager window that lists the contents of a specific directory. The directory window shows all the 
files and subdirectories contained in the directory.



disk-drive icon          

An icon in the Directory Tree window of File Manager that represents a disk drive on your system. 
Different icons depict floppy disk drives, hard disk drives, RAM drives, CD-ROM drives, and network disk
drives.



display box          

A display box is not an option, but a type of text box that shows an example of another option you have 
selected, in this case a sample of the 10 pt, underlined, Helvetica font.



document
Whatever you create with an application, including information you enter, edit, view, or save. A document
can be a business report, a spreadsheet, a picture, and so on.



document file          

Files that are associated with an application. You can start an application and open the associated file by
choosing a document file icon.



document window          

A window inside an application window. Each document window contains a single document or other 
data file. There can be more than one document window inside an application window.



DOS
Disk Operating System, typically known as MS-DOS (Microsoft) or PC-DOS (IBM). This is the underlying
software that must exist for your PC to operate.



drag
A mouse move. You drag a Windows element by pointing to it, holding down the mouse button, and 
sliding the mouse from one spot on the surface of your desk to another and releasing the mouse button.



drop-down list box
A list box that opens and closes in dialog boxes.
Before you open a drop-down list box, it looks like this:

After the list box is open, it looks like this:

NOTE: When the list is longer than the box, scroll bars are provided.



error checking
A method for validating transmissions.



expand
To show hidden directory levels in the Directory Tree. With File Manager, you can expand a single 
directory level, one branch of the Directory Tree, or all branches at once.



expanded memory
Memory in addition to conventional memory that is available to applications. It is allocated in 16K blocks.
Windows makes use of expanded memory only if the /r switch is used at startup. Windows running in 
386 enhanced mode simulates expanded memory for the applications that need it. Windows running in 
standard mode or 386 enhanced mode allows applications to use expanded memory, but does not use 
expanded memory itself in managing applications.



extended memory
Memory in addition to conventional memory that is not readily accessible to MS-DOS or MS-DOS 
applications. Extended memory cannot be used on 8086 and 8088 computers. Windows running in 
standard mode or 386 enhanced mode uses extended memory to manage and run applications.



extended synthesizer
One of the two types of synthesizers accommodated by Windows.
MIDI files authored for Windows include two versions of a song: one version for base-level synthesizers 
and another version for extended synthesizers. The distinctions between base-level and extended 
synthesizers are based on the number of instruments and notes the synthesizer can play.



extension
Part of a file or directory name that appears after a period and provides additional information. It usually 
indicates the type of file or directory. For example, program files have default extensions of .COM 
or .EXE .
Many applications include a default extension automatically when you save a file the first time. For 
example, Notepad adds a .TXT extension to all filenames unless you specify otherwise.



file
A document or application that has been given a name. All documents are stored as files in Wiindows.



file information line          

Information specific to each file in a print queue. The information can include these details:
The file's position in the queue or a printer icon if the file is printing.
The title of the print job assigned by the application (if your network software supports this).
What percentage of the file has printed so far.
The size of the file in kilobytes (if the Print File Size command on the View menu is selected).
The time and date you sent the file to Print Manager (if the Time/Date Sent command on the View

menu is selected).
If you are connected to a network printer, the printer queue information line shows the network server 
connection. Any detailed information the network can provide appears in the message box at the upper-
right corner of the Print Manager window. Networks can provide varying degrees of detailed information.



flow control
The method for controlling the flow of information.



font          
A graphic design applied to all numerals, symbols, and characters in the alphabet. A font usually comes 
in different sizes and provides different styles, such as bold, italic, and underlining for emphasizing text.



font size
The height of a printed character, measured in points. One inch equals 72 points. For example, 12-point 
Helv is 12 points high.

The font and font size you use determine the amount of text that fits on one page. 



format
(1) The appearance of text on the pages of a document. (2) To prepare a disk so it can hold information. 
Formatting a disk erases all information that was previously on it.



full-screen application
A non-Windows application that uses the entire screen--rather than a window--to run in the Windows 
environment.



General MIDI Mode standard
A MIDI specification controlled by the MIDI Manufacturers Association (MMA). The purpose of this 
specification is to enable MIDI file authors to create files that sound the same across a variety of 
different synthesizers.



group
A collection of applications within Program Manager. Grouping your applications makes them easier to 
find.



group icon          

A group window you have reduced to an icon in Program Manager.



group window          

A window that displays the items in a group within Program Manager. These items can be applications, 
files associated with applications, or a combination of both.



History button        

Displays a list of the HyperGuide topics you have viewed. Use this button to revisit any of the last 40 
HyperGuide topics you have viewed. The most recent topic appears first.



hotspot
Text, graphics, or parts of graphics that provide links to other HyperGuide topics or more information 
about the current topic.
Whether text or graphics, the pointer changes to the shape of a hand whenever it is over a hotspot. If 
you click a hotspot that is linked to another topic, that topic will appear in the HyperGuide window. If the 
hotspot is linked to more information, HyperGuide displays the information in a popup window on top of 
the HyperGuide window.



hue
The position of a color along the color spectrum.



HyperGuide button bar          
Contains the HyperGuide buttons you use to move among topics and contents screens. It is located 
near the top of the HyperGuide window.



icon          

A graphic representation of a disk drive, directory, group, application, document, and so on. You can 
restore an application icon to a window when you want to use the application.



insertion point          
The place where text will be inserted when you type.The insertion point usually appears as a flashing 
vertical bar in an application's window or in a dialog box. The text you type appears to the left of the 
insertion point, which moves to the right as you type.



International MIDI Association (IMA)
The non-profit MIDI organization that circulates information about the MIDI specification.



keymaps
Percussion instruments are key-based--each note plays a different percussion instrument. Keymaps 
translate MIDI key values to ensure the proper percussion instruments are used to play MIDI files. All 
MIDI files for Windows are authored using standard key assignments based on the General MIDI Mode 
standard.



keyword
Words in the HyperGuide Search dialog box that are associated with topics. Each application's 
documentation has its own keyword list, including the glossary words in HyperGuide. You select from the
list of keywords or type a keyword to see the list of topics associated with that keyword.



kilobyte
The measurement used for the size of a computer's memory, where 1 kilobyte (K) = 1,024 bytes.



list box          

A box within a dialog box that lists available choices--for example, the list of all available files in a 
directory. If all the choices don't fit in the box, there will be a vertical scroll bar to the right of the list box. 
In some list boxes, you can select more than one item.



local printer
A printer that is directly connected to your printer by a cable.



local queue          

Lists the files that you directed to any active printer connected to your computer. The computer and 
printers are connected locally by a cable.
When Print Manager starts printing on a local printer, its icon appears at the bottom of your screen. If 
you restore the icon to a window, you see the print queue for any active printer connected to your 
computer. You can use the Print Manager window to check the status of files in the print queue or to 
interrupt or cancel a print job.



luminosity
The brightness of the color on a scale from black to white.



maximize
To enlarge a window to its maximum size by using the Maximize button or the Maximize command.



Maximize button          

The small button at the upper-right corner of a window that contains an Up arrow. Mouse users can click
the Maximize button to enlarge a window to its maximum size. Keyboard users can use the Maximize 
command on the Control menu.



Media Control Interface (MCI)
A standard control interface for multimedia devices and files. MCI allows a multimedia application to 
easily control a variety of multimedia devices and files.



memory
The space in a computer where information is stored while you are working with it. Most PCs have a 
small amount of read-only memory (ROM), containing the built-in programs that start the operation of 
the computer when it is turned on, and a large amount of random-access memory (RAM) for users' 
programs and data.



menu          

A list of available commands in an application window. Menu names appear in the menu bar near the 
top of the window. The Control menu, represented by the Control-menu box at the left end of the title 
bar, is common to all Windows applications. You use a command on a menu by selecting the menu 
name, then choosing the command you want.



menu bar          
The horizontal bar containing the names of an application's menus. It appears just under the title bar.



menu command          

A word or phrase in a menu that you choose to carry out an action, such as copying a file.



menu name
The name for a particular menu that appears in the menu bar and opens a menu when you choose it.



menu title
A word or phrase in the menu bar that identifies a group of commands. Selecting the menu title causes 
the title to be highlighted and its menu of commands to appear below it.



MIDI
Musical Instrument Digital Interface. MIDI sets a communications standard for transferring data between
musical instruments and associated devices.



MIDI file
A file format for storing MIDI songs. In Windows, MIDI files have a .MID filename extension. 



MIDI Mapper
A Control Panel option that lets you create and edit MIDI setup maps. Windows uses these maps to 
translate and redirect MIDI data. 



MIDI Sequencer
Software that creates or plays songs stored as MIDI files. When a sequencer plays MIDI files, it sends 
MIDI data from the file to a MIDI synthesizer that produces the sounds. Windows provides a MIDI 
sequencer to play MIDI files.



MIDI Manufacturer's Association (MMA)
A collective organization composed of MIDI instrument manufacturers and MIDI software companies. 
The MMA works with the MIDI Standards Committee to maintain the MIDI specification. 



minimize
To reduce a window to an icon using the Minimize button or the Minimize command. The document or 
application remains open (or running), and can be the active application or document.



Minimize button          

The small button at the upper-right corner of a window that contains a Down arrow. Mouse users can 
click the Minimize button to reduce a window to an icon. Keyboard users can use the Minimize 
command on the Control menu.



movie file
A multimedia data file (for example, a file with the .MMM extension). You can play movie files with the 
Media Player accessory. Movie files are also called animations. 



MSCDEX
Microsoft Compact Disc Extensions. MSCDEX is software that makes CD-ROM drives appear to DOS 
as network drives. You must have MSCDEX installed on your computer for the CD-ROM drive to work. 



multimedia extensions
Additional features added to Windows version 3.0 that enable your computer to run animations, play 
sound and MIDI files, and display high-quality images. 



Multimedia PC
Multimedia personal computer. A multimedia computer satisfies a minimum set of hardware/software 
requirements necessary for multimedia computing. The requirements include:

An 80286/386/486 microprocessor running at 10MHz or faster
2MB or more of RAM
30MB or larger hard disk
VGA display
A digital audio subsystem
A CD-ROM drive
Systems software compatible with Microsoft Windows version 3.0 with multimedia extensions



multitasking
The ability of a single computer to perform several tasks simultaneously.
Multitasking makes it possible to print one document while editing another, or to perform lengthy 
computations while you work on something else.



network printer
A printer that is accessible to your computer only through a network.



network queue
Lists the files on the network server if you are using a network printer.



network server
A computer on a network that provides a particular service to other computers. For example, a disk 
server manages a large file server, and a print server manages a printer.



non-Windows application
An application that was not designed to run in Windows. Generally, non-Windows applications do not 
conform to Windows user-interface standards.



open
To display the contents of a directory or file in a window, or to enlarge an icon to a window.



option button           

A small round button that appears in a dialog box and is used to select an option. Within a group of 
related option buttons, you can select only one button.



palette
Defines the colors used in a bitmap image. Every device independent bitmap (DIB) has an associated 
color palette. 



parity
The method of detecting errors in data transmission.



patch
A specific sound created by a synthesizer. A synthesizer plays notes using sounds defined as patches.



patchmaps
A patch is a specific sound created by a synthesizer. A synthesizer plays notes using sounds defined as 
patches. Patchmaps translate MIDI patch changes to ensure the proper instruments are used to play 
MIDI files. All MIDI files for Windows are authored using standard patch assignments based on the 
General MIDI Mode standard.



pathname
The directions to a directory or file within your system. For example, C:\WINDOWS3\APPTS\JUNE.CAL 
is the pathname of the JUNE.CAL file in the APPTS subdirectory in the WINDOWS3 directory on drive 
C.



picture elements
The smallest graphics unit on the screen. Also known as pels.



pixels
The smallest graphic units on the screen. Also known as picture elements (pels).



playlist
A list of compact disc titles and tracks that determines the order in which the tracks on the disc are 
played. Playlists are only used in Music Box.
Use the Program button to assign or edit titles, and to change the playlist.



pointer          
In Windows, the shape of the pointer indicates its function.

For selecting Windows items, scrolling, resizing windows, 
and moving windows and dialog boxes with your mouse. 
This is the pointer you will see most often.

For choosing a HyperGuide hotspot.

For selecting text with your mouse.

For changing the size of a window with your mouse.

For changing the location or size of a window with your 
keyboard.

For indicating the application is processing your request.

port
A connection on a computer where you plug in a cable that carries data to a device.
LPT ports are parallel ports. COM ports are serial ports. EPT is a port used for certain printers, such as 
the IBM Personal Pageprinter. You can use the EPT port only if you have installed a special card in your 
computer.
Multimedia PCs also have a port for a MIDI sequencer.



print options
Printer-specific settings such as page orientation--portrait or landscape--or the manner in which paper 
feeds through the printer. These options vary from printer to printer.



printer-driver file
A file that gives Windows important information about how to control your printer, including details about 
printer features and the printing interface, descriptions of fonts (such as sizes and styles), character 
translations, and control sequences the printer uses to achieve various formats. Windows has printer-
driver files for most commonly used printers.



printer font
A series of dots connected by lines that can be scaled to different sizes. Another name for printer fonts is
vector (or stroke) fonts. Plotters typically use vector fonts.



printer queue information line          

Indicates the following:
The name of the printer.
Where the printer connects to your computer.
The current status of the printer.



program file          

A file that contains information that controls an application. In File Manager, each program file is 
represented by an icon. You can start the application by choosing the icon. Filenames for program files 
can have these extensions: .EXE, .COM, .PIF, and .BAT.



program information file (PIF)
A file that provides important information that Windows needs to run a non-Windows application. PIFs 
contain information such as the name of the file, a startup directory, whether the program writes directly 
to the screen or to memory, and multitasking options for applications running in 386 enhanced mode.



program item          

A program file or associated document represented by an icon in Program Manager. The program item 
provides the instructions Windows needs to start an application and open a document (if specified) when
you choose the icon.



program item icon          

An icon representing an application you can start or an associated document you can open from a group
in Program Manager. The program item provides the instructions Windows needs to start an application 
and open a document (if specified) when you choose the icon.



RGB components
The amount of each of the three primary colors--red, green, and blue--present in a color. Every color and
pattern is made by varying the three primary colors. This is true even in monochrome (black and white) 
mode. For instance, white is made by mixing together 255 parts of red, 255 parts of green, and 255 
parts of blue. Black, on the other hand, is 0 red, 0 green, and 0 blue.



read-only
Describes a file or CD-ROM disc that can only be opened and read. You cannot edit a read-only file or 
CD-ROM disc and save your changes.



real mode
An operating mode that Windows runs in to provide maximum compatibility with versions of Windows 
applications released prior to Windows version 3.0. Real mode is the only mode available for computers 
with less than 1 MB of extended memory.



Restore button          

The small button at the upper-right corner of a window that contains both an Up arrow and a Down 
arrow. The Restore button appears only after you have enlarged a window to its maximum size. Mouse 
users can click the Restore button to return the window to its previous size. Keyboard users can use the 
Restore command on the Control menu.



root directory
The main directory on a disk. The root directory is created at the first level when you format a disk. The 
symbol used to indicate the root directory of a disk is the backslash (\). For example, the root directory 
for drive C is noted as C:\.



sample
A piece of waveform data represented by a single numerical value. You convert sound into digital form 
by taking samples of the sound at specific time intervals and converting them to numeric values.



saturation
The purity of a hue, moving from gray to the pure color.



scaled font size
A font size that approximates a specified font size for use on the screen. Windows scales larger font 
sizes when a size that is available for the printer is not available for the screen. Scaled fonts may look 
slightly different from unscaled fonts. When you choose a smaller font size that is available for the printer
but not for the screen, Windows substitutes the correct size from a precision-drawn font that resembles 
the selected font as closely as possible.



screen font
A font that duplicates a printer font on your screen.

If you choose a printer font that does not have a corresponding screen font, Windows substitutes a 
screen font that closely resembles the printer font. The substitute font duplicates the line lengths and 
page breaks of the font you selected.
When you purchase extra fonts from a printer or font manufacturer, ask about the availability of screen 
fonts to match.



screen saver
An image or pattern that is shown on your computer screen during periods of inactivity. Screen savers 
hide information currently on the screen; by changing patterns they can also save wear on the 
electronics in the display.



scroll arrow          

An arrow on either end of a scroll bar that is used to scroll through the contents of a window or list box. 
Clicking a scroll arrow moves the contents one line. Holding down a scroll arrow scrolls the contents 
continuously.
Scroll arrows also control the playing of media in some applications, such as Media Player and Sound 
Recorder.



scroll bar          
A bar that appears at the right and/or bottom edge of a window whose contents aren't completely visible.
Each scroll bar contains two scroll arrows and a scroll box, which allow you to scroll within the window or
list box.
A scroll bar is also used to control playing of media in some applications, such as Media Player and 
Sound Recorder.



scroll box          

The square or rectangular box within a scroll bar that indicates your relative position within a document 
or list box. Mouse users can drag the scroll box up or down quickly through long documents.
A scroll box is also used to control playing of media in some applications, such as Media Player and 
Sound Recorder.



Search button          

Displays the keywords you can use to search for topics. Use this button to look for topics related to a 
keyword.



select
To mark an item by highlighting it with key combinations or with a mouse. Selecting does not initiate an 
action. After selecting an item, you choose the action that affects or involves the item. For example, you 
can select text and then choose the Copy command to copy the text onto the Clipboard.



selection cursor          
The marking device that shows where you are in a window, menu, or dialog box and what you have 
selected. The selection cursor appears as a dotted box around the text in a dialog box option.



serial ports
Ports used by your system, named COM1, COM2, and so on. Serial ports are typically used for 
connecting modems, mouse devices, and some kinds of printers.



shortcut key          

A key or key combination, available for some commands, that you can press to carry out a command 
without first selecting a menu. The shortcut key for a command is listed to the right of the command 
name on the menu.



shrink
To reduce a window to an icon using the Minimize button or the Minimize command. The document or 
application remains open (or running), and can be the active application or document.



simple device
Devices, such as audio compact-disc players, that don't have an associated file and can be opened 
without a filename specification.



solid color
A color directly supported by your display.



source directory
The directory containing the file or files you intend to copy or move.



spin box          

A spin box shows one item in a range of possible choices. Clicking the Up or Down arrow to the right of 
the entry lets you "spin" through the available choices until your choice appears in the display rectangle.



standard mode
The normal operating mode for running Windows. This mode provides access to extended memory. In 
standard mode, you can also switch among non-Windows applications.



status bar          
A line of information located at the top or bottom of a window. For example, in a directory window the 
status bar tells how many files are selected, how much disk space they occupy, and the total number of 
files in the directory. In the Directory Tree window, the status bar shows the number of bytes available on
the disk and the total disk capacity. Not all windows have a status bar.



stop bits
The timing unit between characters.
Stop bits are not actually bits; they determine the time between transmitted characters.



synthesizer
An electronic instrument able to make music and sounds by creating its own audio waveforms and 
sending them out to an audio system. A synthesizer can play back MIDI files.



Task List
A window that shows all the applications you have running so you can switch among them. You can 
open the Task List window by choosing Switch To from the Control Menu or by pressing CTRL+ESC.



text box          

A box within a dialog box where you type the information needed to carry out a command. When the 
dialog box appears, the text box may be blank or may contain text.



text file
A file containing only plain text, numbers or symbols. The text in a text file is uniform and does not 
contain any formatting, such as bold, underline, or different fonts and font sizes. A text file usually 
consists of characters coded from the ASCII character set. 
The advantage of a text file is that it can be transferred to almost any text editor or word processor. Also,
MS-DOS and Windows use text files, such as AUTOEXEC.BAT, CONFIG.SYS, and WIN.INI.



title
Another name for a software application written to run on a Multimedia PC. 



title bar          
The horizontal bar at the top of a window that contains the title of the window or dialog box. On many 
windows, the title bar also contains the Control-menu box and Maximize and Minimize buttons.



topic
The level in the HyperGuide hierarchy at which you see information in the main window. This information
can be in the form of a Quick Look graphic, an explanation of a command, a conceptual overview, a 
procedure, or a table of keys. Information in pop-up windows and contents screens are not considered 
topics.



track
A sequence of sound on a CD disc, which usually corresponds to a song.



Up button          

Moves up one level in the HyperGuide hierarchy.



vector fonts
A series of dots connected by lines that can be scaled to different sizes.



virtual memory
A memory management system used by Windows running in 386 enhanced mode, which allows 
Windows to behave as if there were more memory than is actually present in the sytem. Virtual memory 
equals the amount of free RAM plus the amount of disk space allocated to a swap file that Windows 
uses to simulate additional RAM.



volume label          
The name you give a disk by using the Label command. Disk labels are optional. You see this 
information in File Manager only if you assigned a label to your disk. You can change or add a disk label 
through File Manager.



WAVE format
Microsoft's format for digitized waveform files. These files have a .WAV extension.



waveform
A sound waveform displays variances in air pressure over time. An audio signal waveform displays 
variances in voltage over time.



wildcard characters
Two MS-DOS characters you can substitute for all or part of a file or directory name when you want to 
find similarly-named files or want one command to affect a number of files or directories.
An asterisk (*) substitutes for all characters. A question mark (?) substitutes for a single character.
For example, this entry covers all files with a .DOC extension in the current directory:

*.DOC
And this entry covers everything named with FY, three other characters, and the extension .90:

FY???.90



window
A rectangular area on your screen in which you view an application or document. You can open, close, 
and move windows, and change the size of most windows. You can open several windows on the 
desktop at the same time and you can shrink windows to icons or enlarge them to fill the entire desktop.



window border          
The outside edge of a window. You can lengthen or shorten each border. You can also change the width 
of the border with Control Panel's Desktop command.



Windows application
An application that was designed for Windows and will not run without Windows. All Windows 
applications follow the same conventions for arrangement of menus, style of dialog boxes, use of the 
keyboard and mouse, and so on.



wrap
The automatic movement of the insertion point from the end of one line to the beginning of the next line 
as you type. When text wraps, you do not need to press ENTER at the end of each line in a paragraph.






